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Chapter 1
Matrox RT.X2

本章介绍 Matrox RT.X2 的主要功能
及相关的 Matrox RT.X2 文件。
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第 1 章
欢迎使用 Matrox RT.X2
Matrox RT.X2 可以最大限度发挥 Adobe Premiere Pro 和 Adobe 
Production Studio 的功效，是数字影视制作人、多媒体电化教育工作
者、政府和企业宣传部门的理想选择。Matrox RT.X2 专为实时原始 HDV 和
DV 编辑设计，还提供高质量 MPEG-2 4:2:2 I- 帧编解码器，令您可以通过
RT.X2 的模拟输入采集其它高清和标清格式，并在时间线上实时混编各种
素材。

Matrox RT.X2 主要功能
以下为 Matrox RT.X2 系统的主要功能：

·实时多层编辑工作流程，可混编模拟和数字高清及标清素材。

·实时 Matrox Flex CPU 特技：色彩校正特技、变速特技、色度 / 亮度键
特技等。

·实时和加速 Matrox Flex GPU 特技：3D DVE 特技、模糊 / 闪烁 / 软聚
焦特技、闪光特技等。

·原始 HDV 和 MPEG-2 4:2:2 I- 帧高清编辑。

·原始 DV、DVCAM、DVCPRO 和 MPEG-2 4:2:2 I- 帧标清编辑。

·在同一项目里实时混编高清和标清格式视频。

·实时多机位多格式镜头混合。

·将高清时间线以高质量硬件方式实时下转换为标清格式输出。

·加速输出为 DVD、多媒体格式，包括 Flash Video 和 Adobe Clip 
Notes。

·用于 Adobe After Effects、Photoshop 和 Autodesk Combustion 的所
见即所得支持。
，Matrox RT.X2



3

关于本手册
本手册提供关于安装和使用 Matrox RT.X2 硬件和软件所需的相关信息，
并包括如何在 Matrox RT.X2 系统上使用 Adobe Premiere Pro。

手册文字表示方式
本手册使用以下表达方式：

·使用斜体表示文件路径名和手册名。比如：

- 数据存储在 sample.wav 文件中。

- 文件存储在 C:\Windows\System 目录下。

- 请参考 《Matrox RT.X2 安装手册》。

·您要选择的菜单和命令以 Menu > Command 方式显示。比如：File > 

Save 表示在菜单下点击 File，再在出现的菜单中点击 Save。

·键的名称以小的大写黑体显示，如 CTRL 键。

·加号 （+）表示几个键和 /或键与鼠标一同使用。比如：

- CTRL+C 表示按住 CTRL 键的同时按 C 。

- SHIFT+ 点击 表示按住 SHIFT 键的同时点击鼠标。

视频格式表示方法
除了 NTSC 和 PAL 之外，Matrox RT.X2 文件和对话框中的所有标准清晰度
和高清晰度视频格式都表示为：

VRp 或 i @ n fps

其中：

·VR为垂直分辨率。

·p 或 i表示逐行扫描或是隔行扫描视频。

·@ n fps 表示每秒多少帧的帧率。

举例如下：

·486p @ 23.98 fps 表示 720 × 486 逐行扫描视频，帧率为每秒 23.98
帧。

·HDV 1080i @ 29.97 fps 表示 1440 × 1080 隔行扫描视频，帧率为每
秒 29.97 帧。这是 HDV 素材使用的格式。所有 HDV 和高清模拟分量视
频格式素材都将以 HDV 1080i 格式采集到 Matrox RT.X2 系统上。

·1080i @ 29.97 fps 表示 1920 × 1080 隔行扫描视频，帧率为每秒
29.97 帧。Matrox RT.X2 只支持此格式的高清模拟分量视频输入和输
出。
关于本手册
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第 1 章
其它文件
除了本手册外，我们还有其它 Matrox RT.X2 文件：

• Matrox RT.X2 快速安装指南 提供帮助您快速安装Matrox RT.X2系统的
信息。

• Matrox RT.X2 安装手册 提供安装 Matrox RT.X2 硬件和软件的详细信
息，包括如何将外部设置连接到 RT.X2 接口盒上。

• Matrox RT.X2 版本注释 提供最新的产品信息和操作限制。
，Matrox RT.X2



Chapte r 2
定义 Adobe Premiere Pro 设置

本章介绍如何定义Adobe Premiere 
Pro 设置，以使用 Matrox RT.X2。
包括如何指定项目和输出设置。
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第 2 章
同时运行 Adobe Premiere Pro 和其它程序的注意事项
要达到最佳性能，运行 Adobe Premiere Pro 时请不要运行任何其它程序。
如果您确实需要这样做，请确保先打开 Adobe Premiere Pro 和 Matrox 
RT.X2 项目再打开其它程序。否则 Adobe Premiere Pro 有可能无法打开。如
果出现这种情况，先关闭所有程序再打开 Adobe Premiere Pro。

提示：在 Adobe Premiere Pro 运行时，您可以监控 Adobe Premiere Pro 的内
存用量。按在 Matrox X.info （ ） 图标上按住鼠标。要了解更多关于使
用 Matrox X.info 的情况，见第 6章 “监控 Matrox RT.X2 系统”。

设置系统音量电平
要在 Adobe Premiere Pro 中正确采集和播放音频，请确保您按以下指示正
确设置了录音和播放音量电平：

1 双击 Windows 任务条上的音箱图标：

提示： 如果您在 Windows 任务条上看不到音箱的图标，从 Windows 控
制面板中运行 Sounds and Audio Devices，选择 Place volume icon in 

the taskbar，再点击 OK。

2 Choose Options>Properties.
3 从 Mixer device 清单中，确保选择了您要用于 Matrox RT.X2 的音频设

备 。
4 选择 Recording 选项，再选择清单中的所有选项。点击 OK。

5 调整每个音量推子 （Line-in、 Microphone 等 £©，确保它们在合适位
置，比如一半的位置。同时不选择 Mute 选项。

注：有些系统里有可能有 Select 选项而不是 Mute 选项。选择 Select 
打开此音量控制。

6 选择 Options>Properties。

7 选择 Playback 选项，再选择清单中的所有选项。点击 OK。

8 调整每个音量推子 （Line-in、 Microphone 等 £©，确保它们在合适位
置，比如一半的位置。同时不选择 Mute 选项。

9 关闭对话框。
，定义 Adobe Premiere Pro 设置
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运行音频漂移测试
您第一次起动 Adobe Premiere Pro 时，程序将提示您运行音频漂移测试。这
上测试确保在采集和播放模拟素材时 Matrox RT.X2 硬件和声卡间的音频
和视频的同步。点击 Start 运行测试 （需要约五分钟完成测试）。

完成测试后，除非有以下情况出现，您将不再需要测试：

• 您换了声卡。

• 您安装了不只一块声卡，并选择了另一块声卡作为首选的录音 （采
集）声卡。要了解更多关于设置录音首选设备的信息，见您的
Windows 文件。

还有一些情况下，您有可能需要手动运行测试程序：

• 您用一个型号相似的声卡更换了您的声卡 （如果是型号完全不同，程
序会自动提示您运行测试。

• 您升级或是重新安装了声卡的驱动程序。

• 您将声卡移到另一个插槽里。

要手动运行音频漂移检测测试程序：
1 选择 Start > Programs > Matrox Mx.tools > Audio Drift Detection。

2 从 Test Duration 清单中，选择测试时间长度。一般情况下，测试 5 分
钟已足够。

注：如果您经常需要采集很长的素材（超过 1小时），我们建议您选
择更长的测试时间，如 10 分钟。

3 点击 Start 运行测试。
运行音频漂移测试
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第 2 章
装载项目预设
Matrox 的 Adobe Premiere Pro 实时插件包括可装载的项目预设，以马上
应用到相应的 Matrox RT.X2 设置上。要了解如何设置 Matrox 项目预设，
以用于不同类型的项目，见附录 B “Matrox RT.X2 工作流程”。

要装载 Matrox 项目预设：

1 启动 Adobe Premiere Pro。出现 New Project 对话框。

2 从相应的 Matrox文件夹（Matrox - SD用于创建标清项目，或是 Matrox 

- HD 用于创建高清项目），选择与您想创作的项目类型匹配的预设。
比如，如果您想创建一个 NTSC 项目，素材将采集为 DV/DVCAM 格式，
宽高比为标准的 4:3，扩展 Matrox - SD 下的 NTSC 和 Standard 文件
夹，再选择 DV预设。

注：如果您要采集的是 HDV 素材，请为 HDV 素材选择相应的 Matrox 
HDV 预设。比如，如果您的素材是以 Sony 1080/60i 格式拍摄的，选择
Matrox HDV 1080i 29.97 fps 预设。如果您的素材是使用 Sony 
1080/50i 格式拍摄的，选择 Matrox HDV 1080i 25 fps 预设。

3 在 Location 下，指定您需要存储项目的 A/V 驱动器。

4 在 Name 下，输入您的项目的名字。

5 点击 OK 应用设置。 
，定义 Adobe Premiere Pro 设置
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设置临时磁盘
当在 Adobe Premiere Pro 中指定临时磁盘位置时，确保您是按照《Adobe 
Premiere Pro 用户手册》所推荐步骤完成。比如，将视频和音频文件存储
在一个专用的 A/V 驱动器上。

要指定临时磁盘：

1 选择 Edit > Preferences > Scratch Disks。

2 在 Scratch Disks 下，为每个临时磁盘类型选择一个相应的 A/V 驱动器
字母。

提示：要提高性能，请将媒体缓存文件与视频文件存储在不同的驱动
器上。

3 点击 OK 存储设置。

重要：请确保所有的项目都使用同样的临时磁盘设置。这样减少打开新项
目或是已有项目的时间。

在 Adobe Premiere Pro 的 Events 面板中显示报警
Matrox RT.X2 使用 Adobe Premiere Pro 的Events面板来发出某些报警。要显
示这些报警信息，可以双击 Premiere Pro 状态条的报警图标 （ ）、 
（ ）、或 （ ） ，或是选择 Window > Events。要了解关于使用
Events 面板的信息，见 Adobe Premiere Pro 文件。

在同一项目里混编标清和高清素材素材
Matrox RT.X2 支持在高清项目中实时播放标清素材和在标清项目中实时播
放高清素材。但是，素材必须转换为与编辑项目一样的帧尺寸。如果您需
要将所有的素材在输入项目之前都转换好，选择 Edit > Preferences > 

General并选择 Default Scale to Frame Size。此选项不影响已经输入到项
目中的素材。如果只转换序列里的某个素材，在 Timeline 面板上右击此素
材，选择 Scale to Frame Size。

视您的项目视频格式不同，实时缩放素材的支持程度如下表所示：

项目视频格式 所支持的实时缩放

HDV 1080i @ 29.97 fps 上转换 NTSC 素材

HDV 1080i @ 25 fps 上转换 PAL 素材

NTSC 下转换 HDV 1080i @ 29.97 fps 素材

PAL 下转换 HDV 1080i @ 25 fps 素材
设置临时磁盘
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第 2 章
定义常规设置
Matrox Playback Settings 对话框有几个页面，在 Matrox RT.X2 上使用
Adobe Premiere Pro 编辑时，您可以用来进行多种设置。当您选择了一个
Matrox 项目预设，如 DV Standard，系统将为您的项目自动设置一个
Matrox RT.X2 编辑方式，还有几项设置为将优化为使用 Matrox RT.X2 编
辑的设置。

要在 Matrox RT.X2 中调整常规设置：
1 选择 Project > Project Settings > General 并点击 Playback Settings

钮。

2 点击 General 项。 

3 在 Scrubbing Mode 下，选择 Frame、1st Field 或 2nd Field 选择在
Timeline 面板上拖拉序列预览时，您是想显示一帧画面还是只是一
场。比如，在您拖动时间线预览隔行扫描视频时，您有可能想只观看
第一场或是第二场，以消除在停顿时画面出现的闪烁。这种场显示在
电视电影转换时还可用于检查是否有丢帧。

注：如果您使用的是逐行扫描视频，一般情况下，您不会觉察出选择
第一场还是第二场的区别。

4 在 Video Luma Level下，选择在序列上生成和预览视频时您需要应用到
亮度电平上的处理方法：

- Broadcast 使用广播视频标准亮度范围处理视频。过黑和过白亮度
电平 （即低于标准黑电平或超过标准白电平的电平）都被箝位。

- Post Production 使用后期制作视频标准亮度范围处理视频。过黑
和过白亮度电平 （即低于标准黑或超过标准白电平）都被保留。
，定义 Adobe Premiere Pro 设置
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5 在 Error Reporting 下，如果您希望在从 Timeline 面板上播放视频时每
次出现丢帧时都有警告，选择 Report dropped frames on playback，
否则请不选此项。

注：序列播放停止时，序列出现丢帧的部分会出现一个红色条 （即使
您不选择报告丢帧）。

6 在 Frame Hold 下，如果在一个序列里，您想使用 Adobe Premiere Pro 的
定格功能定在某个特定帧上，选择 Enable Frame Hold。如果您选择了
这个功能，在您的素材上加的任何定格特技都将需要生成。如果您选
择了 Enable Frame Hold，在播放带倒放的嵌套的序列或是素材时出现
重复帧或是时间线上出现红色条，但实际上不需要生成，您可以不选
择此项。但如果不选择此项，您在素材上加的定格特技将被忽略。

7 在 Accelerated Premiere Pro Effects 下，您可以选择用于实时 /加速
Premiere Pro 特技的多个选项：

- Disable accelerated scaling to frame size 如果您不希望如第 9 页
“在同一项目里混编标清和高清素材素材”所述转换为您项目的帧
尺寸的素材，您可以选择此项，禁用这个功能。在您添加如 DVE 或
其它在已加了实时尺寸变换的素材上再改变尺寸的特技，全屏的图
像将被缩放，包括任何信封格式和邮筒格式两边的黑边也将被缩
放。如果您禁用加速缩放为帧尺寸的功能，画面两边的黑边将变成
透明，但缩放的素材将需要生成。

- Disable accelerated transitions 如果您想禁用支持此功能的实时
/加速播放 Premiere Pro 过渡特技，选择此项。因为 Matrox RT.X2
模仿 Premiere Pro 的这些特技的不实时版本，如果您想这样做，您
可以禁用加速的过渡特技，回到 Premiere Pro 的不实时版本的特
技，这样就需要生成。

- Accelerate Motion using 如果您想使用实时 / 加速播放 Premiere 
Pro Motion 特技，选择此项。您可以选择以下任意一项决定如何处
理 Motion 特技：

• Matrox move & scale 将Motion特技映射到Matrox基于CPU的移动
/缩放特技上，如果您只需要制作画中画特技，不需要旋转，选
择此项可以达到最佳的画面效果。如果您在制作 Motion 特技时需
要旋转画面，选择此项则需要生成。

• Matrox 3D DVE 将 Motion 特技映射到支持旋转画面功能的 Matrox
硬件加速 3D DVE 特技上。但画面质量不如将 Motion 特技映射到
Matrox移动/缩放特技那么好。您只有在您的显卡支持Matrox硬件
加速特技时才可以映射到 Matrox 3D DVE 特技上。要了解更多信
息，见 129 页 “ 在 Adobe Premiere Pro 里起用和禁用 Matrox 硬件

加速特技”。

8 在 Realtime Indicator Threshold下，拖动滑动指针设置 Matrox RT.X2
决定时间线面板是否实时的门限。向左拖动指针，设置一个较低 （安
全）的门限，向右拖动，设置一个较高的门限。比如，如果您觉得
定义常规设置
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Matrox RT.X2 未标出任何不实时的部分 （即，没有红色条），但将项
目输出到磁带时，出现丢帧，您可以修改此设置，令时间线更多部分
强制生成，以避免丢帧。相反，如果您发现时间线上很多部分显示是
不实时的，但播放时却没有丢帧，您可以将门限提高。

9 点击 OK 存储设置并回到 Project Settings 对话框。

以下章节介绍如何指定 Matrox Playback Settings 对话框的其它设置，用
于在 Matrox RT.X2 上编辑。
，定义 Adobe Premiere Pro 设置
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指定视频输出设置
您可以指定从 RT.X2 接口盒输出的信号的多种设置。

要指定视频输出设置：

1 选择 Project > Project Settings > General，再点击 Playback 

Settings 钮。

2 点击 Video Output。

3 在 Master Output Format下，选择您需要的来自 RT.X2 接口盒的所有视
频输出格式。视您的项目视频格式不同而定，您不一定能够改变主
SDI 输出的格式。

4 如果 Aspect Ratio Conversion 清单可用，比如当高清视频输出需要下
转换为 NTSC 或 PAL，选择以下视频输出中的一项：

- 16x9 Letterbox 输出为 16:9 的信封格式，在 4:3 电视屏幕上显示
时，图像的上和下边缘都加了一条黑条。

- Anamorphic 将 16:9 的图像以水平方向压缩的 4:3 的格式输出，在
宽屏幕电视上播放时将保持图像的垂直分辨率。如果需要在 NTSC 或
是 PAL 监示器上保持正确的宽高比，将监示器设置为显示 16:9 画
面。

5 如果主输出格式为 NTSC，您的项目的视频格式为 486p@23.98 fps，在
Pulldown Method 清单中，选择您需要应用的输出视频的下拉方法
（Standard 2:3 或 Advanced 2:3:3:2）。您只在要录制到支持高级
2:3:3:2 下拉方法的 DV-1394 设备时才选择 Advanced 2:3:3:2。要了解
更多信息，见 “使用标准清晰度 ‘24P’素材”。

6 在 Analog Setup (NTSC) 下，选择您需要的 NTSC 模拟视频设置电平：

- 0 IRE 0 IRE 设置电平。只在使用符合日本 NTSC 0 IRE 设置电平的
商用设备时才选择此项。比如，当在 NTSC 监示器上播放 DV 素材时
如果图像看上去太亮，您可以将输出素材设置为 0 IRE，校正图像亮
度。
定义常规设置
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- 7.5 IRE 标准 NTSC 7.5 IRE 设置电平。

7 在 Analog Output Type 下，选择您需要的模拟视频输出。如果您需要输
出标清模拟视频，您可以选择 Component 或是 Composite & S-Video。
如果您输出高清模拟视频， 模拟输出类型将被设置为 Component。

8 选择 Allow Super White，允许视频输出的最高的亮度电平超过标准的
最高白电平。选择 Allow Super Black，允许视频输出的最低的亮度电
平低于标准的黑电平。

注：超白和超黑的电平在最后输出用于播出的视频时不应使用此选
项。

9 点击 OK 存储设置并回到 Project Settings 对话框。
，定义 Adobe Premiere Pro 设置
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选择 DV-1394 输出设置
您可以从 Timeline 面板里选择通过 1394 接口输出序列，以输出到 DV 磁
带上，并选择 DV-1394 输出的格式。

注：如果要输出到一台 HDV 设备，无需这些设置，如果您制作的是 HDV 
1080i 项目，DV-1394 Output 页面将不可用。

要选择 DV-1394 输出设置：

1 选择 Project > Project Settings > General，点击 Playback Settings

钮。

2 点击 DV-1394 Output。

3 在输出到磁带 （即选择 File > Export > Export to Tape），如果您需
要通过 1394 接口输出序列，选择 Enable 1394 output for export to 

tape。您将可以将序列录制到连接到 RT.X2 系统的 DV-1394 设备上。

重要：因为此选项需要占用更多系统资源，您有可能发现选择了此选
项后，某些原来实时的特技出现丢帧，而且需要生成 （序列上方出现
红色条）。所以您仅在需要将序列输出到 DV 磁带时才选择此项。当您
输出到磁带时，Adobe Premiere Pro 将生成有红色条的部分。

4 从 Output Format 清单中，选择您需要的 DV-1394 输出格式。 比如，要
录制到标准 DV 设备，选择 Matrox DV/DVCAM。

5 点击 OK 存储设置并回到 Project Settings 对话框。

定义视频生成设置
选择您选择 Matrox RT.X2 项目预设时，您用于在 Matrox RT.X2 上编辑的
视频生成设置也将自动设置。您可以按 Adobe Premiere Pro 文件所示指定
其它视频生成设置。
定义视频生成设置
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定义采集设置
Matrox Capture Settings 有可以用于定义在 Matrox RT.X2 上的 Adobe 
Premiere Pro 中采集视频和音频所需要的设置的页面。

注：当您在 Matrox RT.X2 上设置采集设置时，将出现 VU 表，让您可以监
控音频输入电平。要了解更多信息，见 21 页 “监听采集音频电平”。

定义视频采集设置
视项目格式不同，Matrox RT.X2 可以将视频采集为采集为多种视频格式。
比如，如果您的项目是一个标清项目 （如 NTSC），您可以采集为 DV 格
式，如 DVCPRO，以创建为 .avi 文件，用在标清 Premiere Pro 项目中。

要在 Matrox RT.X2 上的 Adobe Premiere Pro 中指定视频采集设置： 

1 选择 Project > Project Settings > Capture。

2 从 Capture Format 清单中，选择 Matrox AVI。

3 点击 Configure 钮，再点击 Video Capture Settings。

4 在 Input Device 下，选择以下一种设备：

- RT.X2 采集连接到 RT.X2 接口盒的模拟视频信号源。

- DV-1394 采集连接到 RT.X2 接口盒的 DV-1394 设备信号源。如果您
制作的是一个 486p @ 23.98 fps 帧率项目，您只能从 DV-1394 设备
采集。

5 如果您选择了 RT.2 接口盒作为输入设备，从 Input Source 清单里选择
您需要采集的输入格式 （Component 、Composite 或 S-Video），如果
采集模拟视频，用于高清项目，系统将自动设置为 Component。
，定义 Adobe Premiere Pro 设置
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备注

- 如果您选择了 DV-1394 作为输入设备，连接到接口盒的 DV-1394 的

设备名将显示在 Input Source 框中。

- 如果 Matrox RT.X2 在您开始采集时不能检测到您的源设备，您将收

到一个出错信息。在从 X.linkSD 采集时，如果没有效的输入信号，

采集结果就会是黑场。在从 X.linkHD 采集时，只有出现有效的输入

信号时，系统才开始采集。在两种情况下，您都需要确保您的设备

已开机，而且正确连接到接口盒，以正确采集视频。

- Matrox RT.X2 为标清项目将 Input Format 设置为 NTSC 或 PAL 制。

如果您在制作一个 HDV 1080i （1440x1080）的项目，您的模拟视频

必须设置为全尺寸 1080i （1920x1080），但它会被采集为 HDV 

1080i （1440x1080）格式。

6 从 Input Aspect Ratio 清单中 ，选择您的视频信号源的宽高比 （4:3
或 16:9）。比如，要采集使用标准电视屏幕格式录制的视频，选择
4:3。要采集使用 16:9 宽屏幕录制的视频，选择 16:9。如果您在定义
用于高清项目的采集设置，Input Aspect Ratio 将设置为 16:9。要采
集为 HDV 格式，正在编辑的项目必须有为 HDV 1080i 项目。

7 在 Capture Format 下，从清单中选择您需要的采集格式。但如果您从
DV-1394 设备采集，视频就会被采集为原始 DV 或 HDV 格式 （Capture 

Format 将被设置为 Native DV/HDV）。要采集为 HDV 格式，您的项目格
式必须是 HDV 1080i 。
注：Capture Format 清单中可用的采集格式视您的项目的视频格式而
定。比如，如果您定义用于标清项目的采集设置，就只有标清采集格
式可用。

- Matrox DV/DVCAM 将视频采集为 DV 或 DVCAM 格式。

- Matrox DVCPRO 将视频采集为 DVCPRO 格式。 

- Matrox MPEG-2 I-frame 将视频以选定数据率采集为 4：2：2 
Profile @ Main Level 的 MPEG-2 I- 帧格式（仅用于标准清晰度）。
要达到最佳色键特技效果，您应该使用此编解码器而不是 DV 编解码
器。）

- Matrox MPEG-2 I-frameHD 将视频以选定数据率采集为 4：2：2 
Profile @ High Level 的 MPEG-2 I- 帧格式 （仅用于高清晰度）。
这是将模拟素材采集为 HDV 1080i 项目的唯一可用的格式。

8 如果您选择了Matrox MPEG-2 I-frame或Matrox MPEG-2 I-frame HD， 点
击 Configure 钮调整 MPEG-2 I- 帧设置。要了解可用设置的详情，见
57 页 “选择 MPEG-2 I 帧设置”。调整好您的设置后，点击 OK 回到
Matrox Capture Settings 对话框。
定义采集设置
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9 如果您需要自动调整复合或S-Video输入信号，以补偿过亮或过暗的画
面，选择 Use Automatic Gain Control （AGC）。这将改善您的图像的
总体亮度和对比度。

10 点击 OK 存储设置并回到 Project Settings 对话框。

定义音频采集设置

您可以指定多种音频采集设置，如指定在 Matrox RT.X2 上采集音频时的

输入源和需要创建的音频文件类型 （.wav 或单声道 .wav）。在 Matrox 

RT.X2 上采集一个素材时，素材的视频和音频文件都存储在一个 .avi 文件

里，素材的音频文件还存储为一个或多个独立的 .wav 文件。您可以使用

如 Adobe Audition 这样的音频后期制作软件来编辑独立的 .wav 文件。

要在 Matrox RT.X2 上的 Adobe Premiere Pro 中指定音频采集设置： 

1 选择 Project > Project Settings > Capture。

2 从 Capture Format 清单中，选择 Matrox AVI。

3 点击 Configure 钮，再选择 Audio Capture Settings。

4 如果您选择 RT.X2 接口盒作为视频输入设备（见 16 页“定义视频采集

设”），您必须还要选择要采集音频的源信号。您的音频源必须如

《Matrox RT.X2 安装手册》所述，与 RT.X2 接口盒上标着 TO AUDIO 

CARD IN 的电缆音频输入相符。比如，如果您您的 TO AUDIO CARD IN

一端连接到声卡的 Line-In 一端 （或是相应插口），从 Input Source

清单中，选择 Line-In。
，定义 Adobe Premiere Pro 设置
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备注

- 如果 Input Source 清单中没有列出所有可用的音频输入，选择 List 

all audio inputs。如果您的音频输入连接没有出现在清单中，您必

须断开 TO AUDIO CARD IN，把它连到声卡上清单中有的插孔上。

- 如果您的模拟音频源出现在清单中，旁边标着一个 *，说明您的声

卡没有相应的音频输入和输出。在这种情况下，选择符合您的音频

输入但旁边有 *的一项，确保您的信号源在播放音频，再点击

Advanced Settings。在出现的对话框里，选择一个模拟音频旁通回

路。如果您可以听到伴音，则您选择了正确的模拟音频源和旁通回

路。否则，选择另一个模拟音频源旁通回路。

- 采集的音频文件的 Capture Format （比特深度） 设置为 16-bit。

5 如果您不希望每次调整Matrox RT.X2 采集设置或是打开Capture 面板开

始采集时，都出现 VU 表，不选择 Show VU meters。此选项为默认设

置。要了解更多关于 VU 表的详情，见 21 页 “监听采集音频电平”。

6 在 Capture Files 下，指示您是想采集成立体声或是单声道音频文件，

再选择您希望将哪个声道存储成为一个独立的 .wav 文件。

- 从 File Type 清单中，选择 Stereo 将采集到的音频存储为立体声

.wav 文件，或是选择 Mono 存储为单声道 .wav 文件。

- 从 Filename 清单中，选择您在从 DV-1394 设备采集时，需要将哪个

立体声道和单声道存储为 .wav 文件，您可以采集最多两个立体声文

件或是 4个单声道文件。如果有哪个 .wav 文件您不想创建，选择

None。当 RT.X2 存储每个 .wav 文件时，它会按您的视频文件的名字

在相关音频文件名字后面加一个 .Stereo.wav 或 .Mono.wav 后缀。

比如，如果您的视频文件叫 MyFile.avi，相关立体声音频文件就叫

MyFile.Stereo1.wav、MyFile.Stereo2.wav，等等。 

备注

- 您选择用来存储第一对立体声 .wav 文件或是前两个单声道 .wav 文

件的声道将被嵌入到相关的 .avi 文件里。当输入 .avi 文件到

Project 窗口时，素材的独立的 .wav 文件也将被输入，.avi 文件的

嵌入音频将被忽略。但素材的 .avi 文件和第一个相关 .wav 文件将
定义采集设置
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在项目中显示为同一个 Movie 素材。只有 .avi 文件没有相关的

.wav 文件时，才会使用 .avi 文件的嵌入音频。因此，如果您需要

对 .avi 文件进行后期制作修改，确保您已删除了相关的 .wav 文

件，这样只有 .avi 文件里的嵌入音频文件将被在项目中使用。

- 在只采集音频时，Matrox RT.X2 支持采集仅一路立体声。第一路立

体声或是前两路单声道将被存储为一个单独的 .wav 文件 （任何其

它声道都会被忽略）。当 RT.X2 将纯音频采集文件存储为一个 .wav

文件时，它不会给文件名后面加一个 .Stereo.wav 后缀。

7 点击 OK 存储设置并回到 Project Settings 对话框。
，定义 Adobe Premiere Pro 设置
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监听采集音频电平
如果您在 Audio Capture Settings页面下选择了 Show VU meters ，每次您调
整 Matrox RT.X2 采集设置或是打开 Capture 面板开始在 Adobe Premiere 
Pro 中采集， VU 表都会显示，让您监控当前选定的音频输入源的电平。

在您播放音频源时，输入电平在低于 –12 dBSF 时是绿色的，在 –12 到 –6 
dBFS 之间时黄色的，超过 –6 dBFS 时是红色的。一旦出现音频箝位，箝位
检测器就会亮起来 （变红）。峰值电平指示是一条红线，显示曾经达到的
最高电平。如果没有新的峰值电平，这些指示器将显示两秒钟。

如果需要的话，调节源设备上的音频电平，将平均输入电平控制在 -30 和
-10 dBSF 之间。您还可以按第 6页 “使用设置系统音量电平”所述使用
Window 音量控制器调节音频输入电平。

箝位检测

峰值电平指示
定义采集设置
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Premiere Pro 输出到磁盘
Adobe Premiere Pro 有几种软件编解码器，可以以不同格式输出视频。
Matrox RT.X2 系统在 Premiere Pro 的基础上再添加几种 Matrox 编解码
器。因为 Matrox 编解码器使用 RT.X2 硬件加速生成，所以速度比使用软
件编解码器更快。

Matrox 编解码器有标清和高清格式。 输出为 Matrox .avi 文件所支持的格式
视您的项目的视频格式而定，如下表所示：

比如，如果您的项目是 NTSC 格式的，您必须选择 NTSC 编解码器。如果
您的项目是 HDV 1080i @ 29.97 fps 格式，您可以选择使用 HDV 1080i @ 
29.97 fps编解码器输出为高清格式，或是您可以选择NTSC编解码器将高清
视频下转换为 NTSC 格式 （这包括正确的高清到标清的色彩空间转换）。

要将序列输出为 Matrox .avi 文件：

1 选择 File > Export > Movie。点击 Settings 钮。从 File Type 清单中，
选择 Matrox AVI。

2 从 Range 清单中，选择一个输出范围，再选择其它输出选项。

3 从对话框左边的菜单中选择 Video。

4 从 Compressor 清单中，选择您需要的输出文件格式。

重要：清单里有 Matrox 编解码器支持的所有标清和高清格式。格式显
示在编解码器名称旁边的括号里，如（NTSC）。确保您选择的 Matrox
编解码器在上表中您的项目支持的格式清单中。 

- Matrox DV/DVCAM 将视频生成为 DV 或 DVCAM 格式。

- Matrox DVCPRO 将视频生成为 DVCPRO 格式。 

- Matrox MPEG-2 I-frame 将视频以选定数据率生成为 4：2：2 
Profile @ Main Level 的 MPEG-2 I- 帧格式 （仅用于标准清晰
度）。

- Matrox MPEG-2 I-frameHD 将视频以选定数据率生成为 4：2：2 
Profile @ High Level 的 MPEG-2 I- 帧格式 （仅用于高清晰度）。

5 如果您选择了Matrox MPEG-2 I-frame或Matrox MPEG-2 I-frame HD， 点
击 Configure 钮选择 MPEG-2 I- 帧设置。要了解可用设置的详情，见

项目视频格式 所支持的输出格式

NTSC NTSC
PAL PAL

486p @ 23.98 fps 486p @ 23.98 fps 或 NTSC
1080i @ 29.97 fps 1080i @ 29.97 fps 或 NTSC

1080p @ 25 fps 1080p @ 25 fps or PAL
，定义 Adobe Premiere Pro 设置
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24 页 “选择 MPEG-2 I 帧设置”。调整好您的设置后，点击 OK 回到
Matrox Capture Settings 对话框。

6 从 Pixel Aspect Ratio 清单中，选择符合您的素材的宽高比：

- D1/DV NTSC （0.9） 用于使用标准电视屏幕格式的 NTSC 或 486p @ 
23.98 fps 素材。如果您将高清视频下转换为 NTSC 格式，输出的视
频将为信封格式。

- D1/DV Widescreen 16:9 （1.2） 用于使用 16:9 宽屏幕格式的
NTSC 或 486p @ 23.98 fps 素材。如果您将高清视频下转换为 NTSC
格式，输出的视频将变形 （水平方向压缩为 4:3）。

- D1/DV PAL （1.067） 用于使用标准电视屏幕格式的 PAL 素材。如
果您将高清视频下转换为 PAL 格式，视频将以信封格式输出。

- D1/DV PAL Widescreen 16:9 （1.422） 用于使用 16:9 宽屏幕格式
的 PAL 素材。如果您将高清视频下转换为 PAL 格式，输出的视频将
变形 （水平方向压缩为 4:3）。

- HD Anamorphic 1080 (1.333) 用于所有未被下转换的 HDV 1080i 素
材。 

7 我们建议您不选择 Recompress。这将最大限度保持视频质量。还将优
化输出速度，因为如果您的素材的压缩和视频格式与您要输出的压缩
格式一样，不含特技的实时部分将直接复制到磁盘上，无需再压缩。

8 点击 OK 存储输出设置。

注：输出的音频将嵌入到相关的 .avi 文件中，还将被存储为一个或
多个独立的 .wav 文件，放在与 .avi 相同的文件夹中。Matrox RT.X2
不支持纯音频输出。
Premiere Pro 输出到磁盘
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第 2 章
选择 MPEG-2 I- 帧设置
当选择使用 Adobe Premiere Pro 以 Matrox MPEG-2 I- 帧或 Matrox 
MPEG-2 I- 帧高清格式采集或输出视频时，可指定多种 MPEG-2 I- 帧压缩
设置。

要选择 MPEG-2 I- 帧设置： 

1 点击 Configure 钮，出现与下图相似的对话框：

2 拖动 Data Rate 滑动指针，直到出现您需要的数据率。您选择的数据率
越高，画面质量越好。可用数据率的范围视您在使用 Matrox MPEG-2 
I 帧高清或是标清格式而定。

重要：视您的系统能力而定，如果您选择的数据率高于 90 Mb/sec，
有可能出现丢帧。

3 要在 MPEG-2 I- 帧文件上应用高级设置，点击 Advanced 钮。

注：默认的高级设置可以为大多数应用提供良好效果。我们建议您只
在有特殊目的时才修改这项设置。 

4 在 Rounding Type 下，选择以下一个选项：

- MPEG-2 在计算量化系数时，将 AC 系数四舍五入到最近的整数。 

- Matrox Custom 在计算量化系数时，将 AC 系数截取最低的整数。在
这种情况下，这个设置在出现图文时有可能失真较小。

5 在 DC Precision 下，选择 DC 帧内编码块的比特深度。

注：您用于采集或生成视频的 DC 精度值越高，在编码的数据流里，DC
内容就会越多，AC 内容则越少。这有可能导致某个数据率下的压缩 
数据流的整体质量降低。

6 在 Zig Zag Type 下，选择以下其中一项：
，定义 Adobe Premiere Pro 设置
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- Regular 按 ISO/IEC 13818-2 （图 7-2） 规格文件设置标准 （默
认）之字形扫描模式 DCT 块的 AC 系数。

- Alternate 按 ISO/IEC 13818-2（图 7-3）规格文件设置 DCT 块的 
AC 系数的反之字形扫描模板。在以高数据率 （比如，对于标清视频
来说，超过 25Mb/ 秒，对于高清视频来说，数据率超过 90 Mb/sec）
采集或是生成视频时使用此设置。

7 选择 Force Frame-based DCT 设置将宏块生成帧而不是场。在某些情况 
下，选择此选项在显示图文时失真较小。

8 点击 OK 存储设置。
选择 MPEG-2 I- 帧设置
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第 2 章
使用 Matrox Media Encoder 输出素材
您可以使用 Matrox Media Encoder 从 Timeline面板中的序列里将素材输出
为多种格式，用于特定的媒体传输，比如 Windows Media 或 RealMedia 数
据流媒体或 MPEG-2 格式，用于 DVD 刻录。比如，您可以使用 Matrox 
Media Encoder 将序列中的视频输出为 MPEG-2 Elementary （.m2v），用于
Adobe Encore DVD。Matrox Media Encoder 提供与 Adobe Media Encoder 一
样的输出格式。但是 Matrox Media Encoder 使用 RT.X2 硬件加速生成，所
以速度和质量更高。

要避免在输出素材用于 DVD 刻录时，在输出的文件里有倒的场序，您必须
按下表所示选择正确的场序：

要使用 Matrox Media Encoder 输出素材：

1 打开 Adobe Premiere Pro。

2 打开您需要输出的项目。

3 如果只需要输出序列的一部分，拖动工作区条，让它超过需要输出的
部分。

4 选择 File > Export > Matrox Media Encoder。

5 从Format清单中选择您需要的输出格式。如果需要输出素材用于DVD刻
录，选择 MPEG2-DVD。

6 从 Preset清单中选择符合您要求的输出类型 Export Settings对话框中
对每种设置有简短的介绍。如果您选择了 MPEG2-DVD 为输出格式，点
击 Video，确保按上表所示选择了正确的场序。

7 点击 OK。

8 指定文件名、存储位置和输出范围，再点击 Save。

Export Settings 对话框中的所有设置都和 Adobe Media Encoder 一样。要
了解如何使用这些设置的详情，见 Adobe Premiere Pro 文件。

项目视频格式 场序

NTSC 第一场

PAL 第一场

486p @ 23.98 fps 无 （逐行）

HDV 1080i @ 29.97 fps 第二场

HDV 1080i @ 25 fps 第二场
，定义 Adobe Premiere Pro 设置



27
设置 Matrox DV/HDV 设备控制
在 Adobe Premiere Pro 中从磁带采集素材或将素材输出到磁带时，可以使
用 Matrox DV/HDV 设备控制来操作 DV-1394 设备。

要设置 Matrox DV/HDV 设备控制：
1 选择 Edit > Preferences > Device Control。

2 从 Devices 清单中，选择 Matrox DV/HDV Device Control。

3 点击 Options 并确保您的设备按照 Adobe Premiere Pro 文件所述正确设
置 （这些选项与 Adobe Premiere Pro 的 DV/HDV 设备控制一样）。

4 点击 OK 存储设置。

现在您可以使用 1394 接口采集或输出素材了 （请确保您的设备设置为
Remote或VTR模式）。要了解如何在Adobe Premiere Pro中采集，见Adobe 
Premiere Pro 文件。要了解如何使用设备控制输出素材，见下一节。

将序列输出到磁带
Matrox RT.X2 可以使用 DV-1394 或 RS-422 设备控制将素材从 Adobe 
Premiere Pro 序列输出到磁带上。您可以使用 Matrox DV/HDV 设备控制控
制 DV-1394 设备。对于 RS-422 设备，您可以按 Adobe Premiere Pro 文件
所述使用串行设备控制。

准备磁带用于录制
要使用设备控制，用来录制素材的磁带必须有连续连贯的时间码。您可以
通过在整个磁带上录制黑电平将整个磁带全部写上时间码。

注：DV 磁带的格式必须与录制格式相配。比如，如果您将 DV-1394 设备的
录制格式设置为 DV/DVCAM，所有时间码必须以 DV/DVCAM 格式写入，不支
持混合格式。

输出到 DV 磁带时避免丢帧
在某些 DV-1394 设备上输出到磁带时，有可能在设备开始录制和 Adobe 
Premiere Pro 开始播放之间出现一个延时。这有可能导致项目的第一个视
频帧没录上。要确保您不丢帧，您需要推迟要输出的项目的播放。

要做到这一点，您需要使用 DV-1394 设备进行一个输出测试，以了解开头
有多少帧没录在 DV 磁带上。在 Adobe Premiere Pro 的 Export To Tape 对
话框中，选择 Delay Movie Start，输入您丢失的帧数的 4 倍 （因为单位
是 1/4 帧）。如果需要的话，调整这个数值，直到您可以进行精确到帧或
是接近精确到帧的输出为止。

注：如果您输出的视频是精确到帧的，但您的音频在 DV 磁带开头处丢帧，
只要在时间线开始处加几帧黑场或是静帧就可以了。如果您这样做，您有
可能不需要使用 Delay Movie start。
设置 Matrox DV/HDV 设备控制
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第 2 章
使用 DV-1394 设备控制输出到 DV 磁带
将 Adobe Premiere Pro 序列输出到 DV-1394 设备时，您可以使用 Matrox 
DV/HDV 设备控制。

要使用 DV-1394 设备控制输出到 DV 磁带： 

1 打开项目并选中需要输出到磁带的序列。

2 确保您的 DV-1394 设备正确连接，开机。

3 除非您是要输出到 HDV 设备，确保起用了 DV-1394 输出端口，用于输出
到磁带，并按 15 页 “选择 DV-1394 输出设置”所述选择了 DV-1394
输出格式。

注：如果您输出到 HDV 设备，Premiere Pro 将检测到您使用的是 HDV
设备，并以原始 HDV 格式输出。

4 如果您使用的是摄录一体机，切换到录像机模式。

5 在 DV-1394 设备中放入一盘写满时间码的磁带。

6 请确保您已按 27 页 “设置 Matrox DV/HDV 设备控制”所述设置好了
Matrox DV/HDV 设备控制。

7 选择 File > Export > Export to Tape。

要了解如何使用 Adobe Premiere Pro 将序列输出到磁带，见您的 Adobe 
Premiere Pro 文件。
，定义 Adobe Premiere Pro 设置
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创建标准清晰度的 16:9 格式项目
Matrox RT.X2 可处理以标准清晰度的 4:3 电视宽高比格式或以 16:9 宽高
比录制的素材。

要使用 Matrox RT.X2 创建一个标准清晰度的 16:9 格式项目，步骤如下：

1 使用摄像机将视频录制到磁带上，将宽高比设为 16:9 。素材会录制成
水平方向压缩的 4:3 视频。

2 启动 Adobe Premiere Pro，选择合适的 Matrox RT.X2 宽屏幕设置（如
DVCPRO Widescreen）。这样在 Matrox RT.X2上创建的特技在使用 16:9 
格式观看时就可以按正确比例显示。

3 按正常操作采集视频信号。将 NTSC 或 PAL 视频监示器上的宽高比选择
为 16:9 以 “拉抻”视频，以宽屏幕格式播放时图像就不会变形。

4 如果使用一个可以设置像素宽高比的程序创建动画、字幕或图文，使
用适当的 16:9 设置以正确显示视频：

- 在 NTSC 或 486p @ 23.98 fps 视频系统上将像素宽高比设为 1.185。

- 在 PAL 系统上，将像素宽高比设为 1.422。

如果无法设置像素宽高比，以 864 x 486 （NTSC 或 486p @ 23.98 
fps） 或 1024 x 576 （PAL）创建图像。创建完图像后，只将宽度调
回为 720。当调整尺寸时，文字或图文在计算机上看上去都拉长了。

5 像编辑标准 4:3 素材一样编辑项目。 

注：请注意，如果您的视频监示器显示为 4:3 格式，某些特技会因为
水平方向拉长而看上去像是拉长了。将监示器设为 16:9 特技就会以正
确比例显示。

6 将完成作品录制在磁带上。请记住您需要一台可显示 16:9 素材的监示
器，以正确观看母带。
创建标准清晰度的 16:9 格式项目
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第 2 章
笔记
，定义 Adobe Premiere Pro 设置



Chapter 3
设置 Adobe Premiere Pro 实时特技

本章介绍如何使用用于 Adobe 
Premiere Pro 的 Matrox 实时插件
设置实时特技。
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第 3 章
可用特技
Adobe Premiere Pro 的 Matrox 实时插件可以：

·设置鲜艳夺目的实时 Matrox 特技及过渡特技。这个插件包括色彩校正
特技、色键特技、亮度键特技、3D DVE、卷页特技、阴影特技其它更多
特技。

注：某些特技只有在使用支持 Matrox 硬件加速特技的显卡时才能显
示。要了解更多信息，见 129 页“ 在 Adobe Premiere Pro 里起用和禁
用 Matrox 硬件加速特技”。

·改变多种特技设置，通过添加或调整关键帧改变特技。

·自定义和裁剪实时特技。

·使用带 alpha 键通道的单帧图文文件创建实时图文叠加层。

·实时制作部分 Adobe Premiere Pro 特技，包括叠化 （视频不透明特
技）、DVE （Motion）和黑白特技。

·给视频素材添加实时变速。

·在使用标清视频时，制作多个实时 Adobe Premiere Pro 过渡特技，在
使用高清视频时，制作多个加速 Adobe Premiere Pro 过渡特技。

实时意味着可以无需生成就可以播放特技和把特技录制到磁带上。您可以
试验不同特技，随时改变创意，马上就可以在视频监示器上看到改变的效
果。除以上提到特技之外的 Adobe Premiere Pro 特技均不是实时的，都需
要生成。要了解如何设置实时特技，见 110 页 “Matrox RT.X2 实时规
则”。

安装Matrox Mx.tools时，Matrox实时插件时特技就加到Adobe Premiere 
Pro 中，可以在作品中使用。Matrox 特技设置和其它 Adobe Premiere Pro
特技设置方法一样。比如，想在素材上加一个 Matrox 过渡特技，就像其
它过渡特技一样，只是出现的对话框让您创建 Matrox 过渡特技，如本章
所述。

要了解如何制作 Adobe Premiere Pro 特技，请参考 《Adobe Premiere 
Pro 用户手册》。

重要：要使用 Matrox 实时插件，必须先定义符合 Matrox RT.X2 的 Adobe 
Premiere Pro 设置，请参考第 2章 “定义 Adobe Premiere Pro 设置”。
，设置 Adobe Premiere Pro 实时特技
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如何在 Adobe Premiere Pro 中制作 Matrox 视频特技
Adobe Premiere Pro 的 Matrox 实时插件可制作很多实时视频特技。要为
素材添加一个 Matrox 视频特技，从 Effects窗口的 Video Effects文
件夹中将需要的特技拖拉到时间线的素材上。

Matrox 视频特技默认位置是 Matrox 文件夹。

提示

·您可以应用一些预先设置好的 Matrox 特技，这些特技在 Matrox 
Effect Presets文件夹下的 Presets中。

·如果您看不到 Effects窗口，选择 Window > Effects。如果您看不
到 Effect Controls窗口，选择 Window > Effect Controls。

如何在 Adobe Premiere Pro 中制作 Matrox 视频过渡特技
在 Adobe Premiere Pro 中，所有 Matrox 划像过渡特技都在 Video 
Transitions文件夹中，在 Effects面板下的 Video Transitions中。

Premiere Pro 中有很多种创建过渡特技的方法。选择适合您的方法来制作
Matrox 划像特技。要了解如果制作过渡特技，见您的 Adobe Premiere Pro
文件。
如何在 Adobe Premiere Pro 中制作 Matrox 视频特技
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第 3 章
自定义素材
很多 Matrox 特技可以通过修改多种自定义设置调整尺寸、位置和旋转参
数。您可以通过两种方式调整自定义设置：

·使用 Effect Controls面板中的自定义钮调节您需要的设置。

·使用鼠标直接在 Adobe Premiere Pro 的 Monitor窗口里的 Program 观看
方式下调节自定义设置。比如，点击您需要的自定义钮 （Position、
Scale、Rotation或 Rotation Center Offset），再在 Program 的
Monitor窗口中点击并拖拉调节自定义设置。您需要在 Program 
Monitor 下启动自定义控制才可以使用这种方法调节自定义设置。要了
解更多信息，见 100 页 “使用 Program 观看方式自定义素材”。

注：如果您使用 Matrox 结晶特技、阴影特技、遮蔽特技、遮蔽模糊特
技、遮蔽马塞克特技或是闪光特技，自定义设置只会加到阴影或是遮
蔽上去，而不会影响整段素材。

使用自定义控制
要使用 Effect Controls面板中的自定义控制调节多项自定义设置，点
击 Transform属性旁边的三角，扩展它： 

您可以在文本框里输入需要的数值或是拖动相应的滑动指针。

·Position （X， Y， Z） 使用此控制调整定义素材在 x （水平）、y
（垂直）和 z （纵向）轴上的位置。 （0，0，0）像素即素材放在屏幕
中央，其它位置从此计算。可输入正或负像素值，左右 （x）、上下
（y）和前后 （z）移动素材。

·Scale （X，Y） 使用此钮调整素材大小。全屏是 100%，可以将素材
缩成 0% 或放大成 100%。注意，素材放大后，分辨率会降低。可独立调
，设置 Adobe Premiere Pro 实时特技
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整各尺寸控制，或如果选择了 Fixed Aspect Ratio，只需要调节一
个 x轴，其它轴自动按比例改变。调节 x 和 y轴的百分比，分别改变
素材宽度和高度。

注：Matrox 表面抛光特技包括了一个 Scale Z属性，您可以用来调节
板块的厚度。要了解更多信息，见 102 页 “制作表面抛光特技”。

·Rotation （X，Y，Z） 使用这些控制设置素材旋转圈数。每 360
度在选定轴上转一圈。 您可以设置反转或正转（从 -360°到 360°）。

·Rotation Center Offset （X，Y，Z） 使用 Rotation Center 
Offset控制设置素材在 x （水平）、y （垂直）和 z （深度）上的重
心或旋转中心。设置了 Rotation后，素材以此点为中心旋转，可使用
正或负像素值在每个轴上移动素材。

下图中，请注意不同 Offset值会如何影响立方体旋转。

图 1中，Offset值为 （0，0，0），所以立方体的旋转中心是坐标原点，
图 2中，Offset的 x 坐标为 100，所以重心向右移，立方体以此为中心
旋转，弧度比图 1大。

Y

X

Z

Y

X

Z

图 1： Offset 为 0，0，0 图 2： Offset 为 100，0，0
自定义素材
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使用 Program 监示器自定义素材
可以使用鼠标左键在 Program 监示器里直接调整素材的大小、位置和旋转
素材。支持在 Program 监示器中自定义素材的特技在 Effects Controls
面板里的特技名左边有一个自定义图标。 

注：在制作某些特技时，Transform 图标令您可以直接在 Program 
Monitor 中设置特技，而不需要按此节所述调节特技设置。

要启动 Program 监示器下的自定义控制，在 Effect Controls面板里点
击 Matrox 特技。直接控制方式钮将出现在 Program 监示器的左上方：

先点击相应钮 （Position、Scale、Rotation或 Rotation Center 
Offset）选择要调节的自定义设置。Precision Mode只在 Program 监示
器里可用，令您可以精确调节当前的自定义设置。

下表显示使用 Program 监示器时，可用的鼠标控制。

比如，如果只想在 y 轴上调整素材位置，先点击 Position钮再按住 SHIFT

同时在 Program 监示器上下拖动鼠标。

操作 效果

鼠标左键 调节 x 和 y 轴

SHIFT+ 鼠标左键，左或右拖动 只调节 x 轴

SHIFT+ 鼠标左键，上或下拖动 只调节 y 轴

CTRL+ 鼠标左键，上或下拖动 只调节 z 轴

自定义图标

位置
尺寸

旋转
旋转中心

精确方式
 

，设置 Adobe Premiere Pro 实时特技
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裁剪素材
很多 Matrox 特技允许您对特技进行裁剪。要应用裁剪设置，点击 Crop旁
边的三角，扩展属性清单：

Crop下的控制钮可以裁剪素材的任意边缘。您可以输入您想要裁剪的数
值，或是拖拉相应的滑动指针 （Left、Right、Top、Bottom）裁剪素
材。

·Crop Left 裁剪素材的左边缘。

·Crop Right 裁剪素材的右边缘。

·Crop Top 裁剪素材的上边缘。

·Crop Bottom 裁剪素材的下边缘。

·Select Crop 显示一个对话框，您可以在里面调整裁剪设置。要了
解详情，见 38 页 “使用选择性裁剪”。

·Stretch to original size 选择此项，令裁剪后的素材拉伸成原
来素材的尺寸。

注： 如果您使用的 Matrox 特技没有提供 Crop属性，您可以使用
Adobe Premiere Pro 的裁剪特技实时裁剪素材 （在 Transform文件夹
下 Video Effects文件夹里）。除非您启用了 Zoom选项，Premiere 
Pro 的裁剪特技会一直保持实时。要了解使用 Premiere Pro 裁剪特技
的详情，见 Adobe Premiere Pro 文件。
裁剪素材
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使用选择性裁剪 
要使用 Select Crop修改素材的裁剪设置，点击 Select属性旁边的三
角，扩展它，再选择 Select Crop钮：

Select Crop对话框允许您以两种方式裁剪素材：

·在 Select Crop窗口里点击并拖拉鼠标以创建一个矩形的裁剪区域。

要改变矩形区域的尺寸，拖动矩形的任意边。比如，拖动右边缘调整
矩形的右边缘。要一次调整整个矩形，拖动矩形的一个角 （它的对角
将固定不动）。

·使用 Left、Right、Top和 Bottom控制，按指定的像素数裁剪任何边
缘。您可以在文本框里输入数值，或是拖动滑动指针调整裁剪区域。
比如，拖动 Left滑动指针裁剪素材的左边缘。
，设置 Adobe Premiere Pro 实时特技
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给特技添加一个遮蔽
很多 Matrox 特技允许您添加一下遮蔽，以定义一个要加特技的区域。比
如，您只想给画面上某个部分加上一个色彩校正特技，而其它部分保持原
状。 

在亮度或是色度键特技上加一个遮蔽并选择 Transparent Outside Mask
令您可以将特技只加在遮蔽的部分，只有下面一层的画面显示在键以外的
区域。比如，您可以定义一个您需要加键的部分，而且键以外的部分为下
面一层的画面。这个功能在您无法抠像前景画面边缘时很有用。

要调节遮蔽属性： 

点击 Mask旁边的三角，扩展属性清单。 

Mask下的属性令您可以控制需要加遮蔽的区域。您可以在文本框里输入
数值或是拖动相应的滑动指针 （Left、Right、Top和 Bottom）。

·Left 调节遮蔽的左边缘。

·Right 调节遮蔽的右边缘。

·Top 调节遮蔽的上边缘。

·Bottom 调节遮蔽的下边缘。

·Select Mask 显示一下对话框，您可以在里面调整遮蔽设置。要了
解详情，见 40 页 “使用选择性遮蔽”。

·Invert 反转遮蔽，将特技加在遮蔽以外的区域，而不是以内的区
域。
给特技添加一个遮蔽



40

第 3 章
使用选择性遮蔽
要使用 Select Mask对话框给 Matrox 特技加一个遮蔽，点击 Select属
性旁边的三角，扩展它，再点击 Select Mask钮：

Select Mask对话框允许您以两种方式调整遮蔽：

·在 Select Mask 窗口里点击并拖拉鼠标以创建一个矩形的遮蔽区域。

在改变矩形区域的尺寸，拖动矩形的任意边。比如，拖动右边缘调整
矩形的右边缘。要一次调整整个矩形，拖动矩形的一个角 （它的对角
将固定不动）。

·使用 Left、Right、Top和 Bottom控制，按指定的像素数调节遮蔽的
任何边缘。您可以在文本框里输入数值，或是拖动滑动指针调整遮蔽
区域。比如，拖动 Left滑动指针调整遮蔽的左边缘。
，设置 Adobe Premiere Pro 实时特技
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制作色彩校正特技
色彩校正对于所有制作来说都非常重要，无论是要令各镜头之间色调保持
一致、保证符合广播安全电平或是加强画面效果都要使用这个特技。
Matrox 色彩校正提供基本 proc amp 控制、包括总体亮度、阴影、中间亮
度或是高光控制的色彩校正、还有高光控制及输入输出电平控制。您可以
轻而易举地按照基准镜头匹配颜色。要了解更多关于颜色匹配的详情，见
46 页 “匹配两段素材”。

提示：Adobe Premiere Pro 包括了一个操作空间设置，专为处理素材和特
技优化设计，令色彩校正更加方便快捷。要使用适合色彩校正特技的操作
空间，选择 Window > Workspace > Color Correction。

要设置 Matrox 色彩校正特技：

点击 Matrox Color Correction旁边的三角，扩展属性清单。

·Proc Amps 处理放大器 （proc amp）控制可以调节素材不同参数：

- Hue 调节图像的色调。

- Saturation 调节图像颜色饱和 （鲜艳）度。

- Contrast 调节图像中最亮与最暗部分之间的差别。

- Brightness 调节图像的黑电平。

·Color Balance 可以调节素材中各种颜色的混合。

- Graphical 允许您在调节颜色平衡时通过图形看到画面的变化。
您还可以在图中调节大多数颜色平衡设置。要了解更多详情，见 43
页 “使用颜色平衡图”。

- Numerical 可以通过在文本框里输入数值或是拖动相应滑动指针
来调节颜色平衡设置。您可以调节每种亮度范围的 Hue、
Saturation和 Luminance。
制作色彩校正特技
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• Master （Hue、Saturation和 Luminance） 影响素材从最亮
的白色到最暗的黑色的所有区域。

• Shadows （Hue、Saturation和 Luminance） 只影响素材最
暗的部分。

• Midtones （Hue、Saturation和 Luminance） 只影响素材最
暗与最亮之间的部分。

• Highlights （Hue、Saturation和 Luminance） 只影响素材
最亮的部分。

·Luma Mapping

- Graphical 允许您在调节亮度映射设置时通过图形看到画面的变
化。您还可以在图中直接调节素材亮度。要了解更多详情，见 48 页
“使用亮度映射图”。

- Numerical 可以通过在文本框里输入数值或是拖动相应滑动指针
来调节亮度映射设置。

• Input Levels （Black和 White）  通过改变对应黑、白或灰
的亮度值精确调节素材亮度和对比度。这样做同时扩展或压缩素
材的亮度电平，即增加或减少素材的颜色范围。

比如，增加黑电平值，素材的黑色部分就设置为一个更高的亮度
值，亮度范围按比例压缩了，画面变得更黑。

• Output Levels （Black 和 White） 可以将 Input Levels的
值映射到任何黑和白电平上。您可以降低素材的对比度，或是通
过将黑值设得比白值高反转素材亮度。

• Gamma 使用此控制调节素材的中间亮度部分，无需调节黑或白
电平。

·Mask  可以在特技上加一个遮蔽。要了解详情，见 39 页 “给素材添
加一个遮蔽”。
，设置 Adobe Premiere Pro 实时特技
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使用颜色平衡图
可在颜色图中直接修改每种亮度范围的 Color Balance设置。您还可以
使用颜色图旁边的钮进行自动平衡或是颜色平衡处理。要了解详情，见 45
页 “自动平衡”和 46 页 “匹配两段素材”。视您使用的颜色不同，您可
以总体调节素材颜色，或是只调节阴影、中间亮度或高光范围内的素材颜
色。

您可以拖动在任何颜色图中心的点，调节某个特定亮度范围的颜色平衡
（Hue和 Saturation）。比如，要总体调节素材的颜色平衡，使用
Master颜色图，或是使用 Shadow颜色图只调节阴影部分的颜色平衡。
向您需要的颜色拖动十字叉丝，或是远离不需要的颜色。比如，如果您将
叉丝向红色移动，您同时减少同样的青色。如下图所示：

MAGENTARED

YELLOW BLUE

CYANGREEN
制作色彩校正特技
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如果您想恢复颜色平衡 （Hue和 Saturation）设置，点击您正在使用的
颜色图的恢复颜色平衡默认设置钮。

自动平衡和匹配素材颜色
您可以使用每个颜色图下面的参考颜色和匹配颜色钮进行自动平衡和颜色
匹配。 

颜色平衡
复位钮
，设置 Adobe Premiere Pro 实时特技
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自动平衡
在匹配颜色之前，您可以在目标素材上加一个自动平衡，令颜色自动向您
的素材偏移，以补偿不同灯光环境带来的区别。在相应的颜色图下点击 
Auto Balance ，并使用颜色吸管选择素材上需要颜色校正的区域的颜色。
比如，要调整素材的高光部分，点击 Highlights颜色图下的 Auto 

Balance 钮，再点击 （或点击拖拉）您素材最亮的部分。自动平衡马上完
成。

注：要进行自动白平衡，在 Master 颜色图下点击 Auto White Balance 

钮，并在您的素材的白色或是浅灰色区域上点击 （或点击并拖拉）。

自动平衡钮
制作色彩校正特技
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匹配两段素材
您可以加一个颜色匹配特技，匹配两段素材的颜色 （如肤色、天空等）。
颜色匹配功能令您可以从参考素材里选择一种颜色，令目标素材与这个颜
色匹配。您可以调整素材的总体颜色 （Master），或是只调整 Shadows、
Midtones或 Highlights。

您可以点击颜色选择钮或是颜色吸管，选择您的参考颜色和匹配颜色。

吸管有两种使用方法：

- 点击颜色吸管，再在素材上点击需要的颜色。

- 点击颜色吸管，再在素材点击并拖拉鼠标，创建一个包含您需要的
颜色的矩形区域。选择的颜色值为这个区域所有像素的平均值。

要进行颜色匹配：

1 选择 Window > Workspace > Color Correction，为色彩校正准备
好工作空间。

2 在 Source 监示器上打开目标素材 （含有需要校正的颜色的素材）。

注：如果目标素材有多个特技，要达到最佳效果，创建一个嵌套的序
列，在加色彩校正之前在 Source 监示器里打开它。要了解更多关于创
建嵌套序列的信息，见 Adobe Premiere Pro 文件。

3 在时间线上的目标素材上加 Matrox Color Correction 特技。

4 使用参考监示器里的控制钮移动参考素材，找到包含您需要匹配的颜
色的帧中。

5 使用 Source 监示器里的控制钮移动目标素材，找到素材中需要匹配颜
色的帧。

6 在您需要调整的亮度图 （Master、Shadows、Midtones或
Highlights）下，使用参考颜色吸管从参考素材中选择一个颜色。 

比如，要令目标素材与参考素材中的一个非常暗的颜色匹配，点击
Shadows颜色图下的参考颜色吸管，再点击 （或是点击拖拉）参考素
材上需要的颜色。

颜色吸管颜色吸管钮

参考颜色吸管
，设置 Adobe Premiere Pro 实时特技
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7 在目标素材相应的颜色图 （Master、Shadows、Midtones或
Highlights）下，使用匹配颜色吸管在 Source 监示器中从从目标素
材上选择一个匹配颜色。

匹配颜色吸管
制作色彩校正特技
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使用亮度映射图
要在图中直接调整亮度映射值，点击 Luma Mapping Graphical属性旁
边的三角，扩展它：

·Map 这是您首次扩展 Graphical属性时默认出现的图。您可以在图
中拖动鼠标调节黑和白电平的 Input 和 Output电平，还可调节
Gamma。

1 输入 黑
电平

2 输入白
电平

3 输出黑
电平

4 输出白
电平

5 Gamma

1
2

3

4

5

，设置 Adobe Premiere Pro 实时特技
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·Plot 点击此钮，以柱状图显示当前帧的亮度 （柱状图将显示您所做
的任何色彩校正变化）。每种亮度值表示为一条垂直线。长一点的线表
示此亮度值的像素多一些。您可以拖动图的边缘调节黑和白电平的
Input和 Output及 Gamma值。

·Auto Black 点击此钮将画面最暗的像素定义为黑。中间的亮度值
按比例分配。

·Auto White 点击此钮将画面最亮的像素定义为白。中间的亮度值按
比例分配。

注：任何时候如果您需要将亮度值恢复为默认设置，点击复位钮。

1 输入 黑
电平

2 输入白
电平

3 输出黑
电平

4 输出白
电平

5 Gamma

1 2

3

4

5

复位钮
制作色彩校正特技
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制作局部色彩校正特技
局部色彩校正提供 Matrox 色彩校正特技的所有属性，它可以使用某些键
属性只将特技加在某个范围内的像素上。比如，局部色彩校正特技可以用
于如改变图像上一条裙子的颜色、加深背景天空的颜色或是画面上只有一
个物体或是人是彩色的，其它部分都是黑白的效果。要了解如果将一种颜
色分离出来，令画面的其它部分都是黑白的，见 59 页 “制作颜色分离特
技”。

提示：Adobe Premiere Pro 包括了一个操作空间设置，专为处理素材和特
技优化设计，令色彩校正更多方便快捷。要使用适合色彩校正的操作空
间，选择 Window > Workspace > Color Correction。

要设置 Matrox 局部色彩校正特技：

点击 Matrox Secondary Color Correction 旁边的三角，扩展属性清
单。

·Proc Amps 处理放大器 （proc amp）控制可以调节素材不同参数：

- Hue 调节图像的色调。

- Saturation 调节图像颜色饱和 （鲜艳）度。

- Contrast 调节图像中最亮与最暗部分之间的差别。

- Brightness 调节图像的黑电平。

·Color Balance 可以调节素材中各种颜色的混合。
，设置 Adobe Premiere Pro 实时特技
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- Graphical 允许您在调节颜色平衡时通过图形看到画面的变化。
您还可以在图中调节大多数颜色平衡设置。要了解更多详情，见 43
页 “使用颜色平衡图”。

- Numerical 可以通过在文本框里输入数值或是拖动相应滑动指针
来调节颜色平衡设置。您可以调节每种亮度范围的 Hue、
Saturation和 Luminance。

• Master （Hue、Saturation和 Luminance） 影响素材从最亮
的白色到最暗的黑色的所有区域。

• Shadows （Hue、Saturation和 Luminance） 只影响素材最
暗的部分。

• Midtones （Hue、Saturation和 Luminance） 只影响素材最
暗与最亮之间的部分。

• Highlights （Hue、Saturation和 Luminance） 只影响素材
最亮的部分。

·Luma Mapping

- Graphical 允许您在调节亮度映射设置时通过图形看到画面的变
化。您还可以在图中直接调节素材调节亮度映射设置。要了解更多
详情，见 48 页 “使用亮度映射图”。

- Numerical 可以通过在文本框里输入数值或是拖动相应滑动指针
来调节颜色平衡设置。

• Input Levels （Black和 White）  通过改变对应黑、白或灰
的亮度值精确调节素材亮度和对比度。这样做同时扩展或压缩素
材的亮度电平范围。

比如，增加黑电平的值，素材的黑色部分就设置为一个更高的亮
度值，亮度范围被压缩了，图像按比例变暗。

• Output Levels （Black 和 White） 可以将 Input Levels的
值映射到任何黑和白电平上。您可以降低素材的对比度，或是通
过将黑值设得比白值高反转素材亮度的效果。

• Gamma 使用此控制调节素材的中间亮度部分，无需调节黑或白
电平。
制作局部色彩校正特技
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·Mask  可以在素材上加一个遮蔽。要了解详情，见 39 页 “给素材添
加一个遮蔽”。

·Selective Key 选择键令您可以将色彩校正特技只加到某个范围内
的像素上。选择键跟色键或是亮度键相似，但使用选择键，您可以在
加键的部分制作色彩校正，而不是加在透明的部分上。比如，如果您
使用选择键属性选择红色为 Hue颜色，色彩校正就只加到画面上红色
的部分。您可以单独启用每个键 （Hue、Saturation和 Luma）或是
同时启用三种控制，以达到需要的效果。

- Graphical 允许您在调节选择键 Numerical 设置时通过图形看到
画面的变化。您还可以在图中直接调节素材设置，加一个自动键。
要了解更多详情，见 55 页 “使用选择键图”。

- Numerical 可以通过在文本框里输入数值或是拖动相应滑动指针
来调节键设置。

• Hue Key  此类型的键可以按色调选择需要加键（加色彩校正特
技）的区域。

- Enable 选择此键启用选择性键图中的 Hue Key 属性和色调键
指示器。

- Hue 用此键延颜色频谱图的边缘旋转指示器，以选择需要加键
的颜色。

- Aperture 使用此键加宽或是缩窄指示器的节距，以增加或是
减少您需要加键的颜色的范围。

- Softness 设置在节距区域里定义的颜色的柔度。

• Saturation Key 此类型的键可以按色饱和度选择需要加键
（加色彩校正特技）的区域。淡颜色色饱和度低，鲜艳的颜色色
饱和度高。

- Enable 选择此控制启用选择性键图中的 Saturation Key
属性和色调键指示器。

- Low Clip 使用此控制选择给低饱和度的部分加键。 

- Low Gain 使用此控制，按您在 Low Clip控制中设置的值决

定您需要部分影响的色饱和度值。增加 Low Gain设置，更多

像素将部分受到色彩校正特技影响。如果您降低 Low Gain控

制，较少像素部分受影响。

Low Gain设置为 100 提供最宽范围的色彩校正。相反，设置为

0表明画面的色饱和度要么完全受影响，要么完全不受影响。

您可以将 Low Gain控制理解为对画面淡颜色的区域 “从完全

受影响到完全不受影响”的受影响程度的指标。
，设置 Adobe Premiere Pro 实时特技
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- High Gain 此控制与 Low Gain相似，区别只是在于您使用此
控制，按在 High Clip控制中设置的值决定您需要部分影响的
色饱和度值。增加 High Gain设置，更少像素将部分受到色彩
校正特技影响。如果您降低 High Gain控制，较多像素部分受
影响。您可以将 High Gain控制理解为对画面淡颜色的区域
“从完全不受影响到完全受影响”的受影响程度的指标。

- High Clip 此控制与 Low Clip相似，只是使用此控制选择给
较高饱和度的区域加键。

注：您使用 Low Clip 和 Low Gain控制设置的值视您的

High Clip 和 High Gain控制而定，反之亦然。这将防止高

和低控制都在同一样的值上加键。

• Luma Key 此类型的键可以按亮度选择需要加键 （加色彩校正特

技）的区域。

- Enable 选择此控制启用选择亮度键图中的 Luma Key 属性和
亮度键指示器。

- Low Clip 使用此控制选择较暗的像素加键。Low Clip设置
为 0时表示黑，255 表示白。中间的值代表不同程度的灰，从
很暗到很亮的灰。

- Low Gain 使用此控制，按您在 Low Clip控制中设置的值决
定您需要部分影响的亮度值。增加 Low Gain设置，更多亮度
值的像素将部分受到色彩校正特技影响。

- Low Gain设置为 100 提供最宽范围的色彩校正。相反，设置为
0表明画面的色饱和度要么完全受影响，要么完全不受影响。
您可以将 Low Gain控制理解为对画面的暗的部分 “从完全受
影响到完全不受影响”的受影响程度的指标。
制作局部色彩校正特技
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- High Gain 此控制与 Low Gain相似，区别只是在于您使用此
控制，按在 High Clip控制中设置的值决定您需要部分影响的
亮度值。您可以将 High Gain控制理解为对画面较亮的区域
“从完全不受影响到完全受影响”的受影响程度的指标。

- High Clip 此控制与 Low Clip相似，不同之处在于您使用此
键选择较明亮的像素加键。

注：您可以使用 Low Clip和 Low Gain控制选择的值视 High 
Clip 和 High Gain控制而定，反之亦然。 这可以防止低和高控
制钮都在同一亮度的像素上加键。

• Invert Key 选择此控制反转键选择，令您得到与原来选择完全
相反的效果 

• Show Key as Output 选择此控制显示用于定义您的选择键区域
的遮蔽。这可以进一步精确调整键。完全受到色彩校正特技影响
的部分是白色的，完全不受影响的部分为黑色，部分受影响的部
分是灰色。

• Expand Outside Mask 在遮蔽区域外的部分加色彩校正。这在
您需要加颜色保留特技，画面上有几处是同一种颜色，但您只想
保留其中一处的颜色的时候很有用。要了解更多详情，见 59 页
“制作颜色分离特技”。
，设置 Adobe Premiere Pro 实时特技
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使用选择键图
选择键图允许您可以直接在图中修改您的选择键设置 （Hue Key、
Saturation Key和 Luma Key）。您还可以制作一个自动键。

·Map 这是您首次扩展图属性时出现的默认界面。您可以拖动控制，将
指针移动到图上的不同区域，以调节 Hue Key、Saturation Key和
Luma Key设置。

要看到指示器和控制，您需要启动您要使用的键设置。比如，如果您
需要调节 Hue Key属性，您需要点击选择键图中的 Hue钮，或是选择
Hue Key数字属性中的 Enable选项。在以下图中，Hue属性被启用
了。

·Plot 点击此钮观看您的素材的当前帧的亮度和色度分部图。您可以
拖动控制钮将指示器移动到图中的不同区域，以调节 Hue Key、
Saturation Key和 Luma Key属性。亮度柱状图以柱显示每种亮度值
下的像素数。长一点的线表示有更多的像素有此亮度值。
制作局部色彩校正特技
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·Hue 点击此钮启用或是禁用 Hue Key属性 （Hue、Aperture和
Softness）。当启用此控制时，您将可以看到 Hue Key指示器和控制
钮，可以在选择键图里调整 Hue Key属性。

1 色调 2 节距 3 柔度

1

2

3

2

3

，设置 Adobe Premiere Pro 实时特技
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·Sat 点击此钮启用或是禁用 Saturation Key属性 （Low Clip、
Low Gain、High Gain和 High Clip）。当启用此控制时，您将可以
看到 Sat Key指示器和控制钮，可以在选择键图里调整 Saturation 
Key属性。

·Lum 点击此钮启用或是禁用 Luma Key属性 （Low Clip、Low 
Gain、High Gain和 High Clip）。当启用此控制时，您将可以看到
Luma Key指示器和控制钮，可以在选择键图里调整属性。

1 低亮度素材 2 低增益 3 高亮度素材 4 高增益

1 低亮度素材 2 低增益 3 高亮度素材 4 高增益

1 2 3 4

1

2 3

4

制作局部色彩校正特技
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提示：对于 Saturation Key和 Luma Key属性，您可以按住 SHIFT 的
同时拖动控制，在选择键同时锁定所有控制钮并一起移动它们。如果您
按 CTRL，您可以同时锁定 Low Clip和 Low Gain控制或 High Gain和
High Clip控制。 

注：任何时候您需要将色调、色饱和度和亮度键属性恢复为默认值，点
击相应的复位钮。

·Show Key 点击此钮显示用于定义您的选择键区域的遮蔽。这可以进
一步精确调整键。完全受到色彩校正特技影响的部分是白色的，完全
不受影响的部分为黑色，部分受影响的部分是灰色。

·Auto Key 点击此钮自动给当前帧最常用的颜色加键 （灰色除外）。选
择 Auto Key影响 Hue Key、Saturation Key和 Luma key的属性。
同样，您可以使用吸管选择您需要加键的颜色。吸管有两种使用方法：

- 点击吸管钮，再点击您需要加键的颜色。

- 点击吸管钮，再在素材上包含了需要加键的颜色的部分拖拉鼠标，
创建一个矩形区域。选定的颜色将是这个矩形区域里的像素的平均
颜色。

·Indicator 点击此钮显示或隐藏指示线。

·Handles 点击此钮显示或隐藏指示线控制。

色饱和度键

复位钮
，设置 Adobe Premiere Pro 实时特技
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制作颜色分离特技
您可以使用 Matrox 局部色彩校正特技制作颜色分离特技，只保留画面里
的一个颜色，其它部分变成黑白的。这个特技在您想突出画面某一颜色时
非常有用。

以下加了颜色分离特技的例子中，小女孩的衣服的粉红色被保留下来，画
面其它部分转换成黑白的：

要制作颜色匹配特技：

1 在选择键图中点击 Auto Key 吸管，在素材中任意位置拖动鼠标，选中
一个包含想保留的颜色的矩形框。

2 在 Proc Amps下，将 Saturation设置为 0。

3 选择 Invert Key。

如果您画面上有几处有同样的颜色，但您只想保留一处的颜色，您可以使
用 Expand Outside Mask选项，在包含您需要保留的颜色的部分加一个
遮蔽。比如，如果您的画面上有两朵玫瑰花，都是一样的红色，而您只想
保留其中一朵的颜色，您可以这样做：

要使用 Expand Outside Mask 选项加一个颜色分离特技：

1 在选择键图中点击 auto key 吸管，在素材中任意位置拖动鼠标，选中
一个包含想保留的颜色的矩形框。

2 在 Proc Amps下，将 Saturation设置为 0。

3 选择 Invert Key。

4 在您需要保留颜色的部分加一个遮蔽 （见 39 页 “给素材添加一个遮
蔽”）。

5 选择 Expand Outside Mask。

衣服的粉红色被保留下
来了，其它部分变成黑
白的
制作局部色彩校正特技
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制作 3D DVE 特技
Matrox 3D DVE 令您可以将素材实时摆放在三维空间的任意位置，同时可
以加一个柔边和带颜色渐变的圆边。

如：如果您想制作一个画中画特技，移动 /缩放特技的画面质量会更清晰
一些 （见 86 页 “制作移动 /缩放特技”）。但如果您再想旋转画面，就
必须使用 3D DVE 特技。

要设置 Matrox 3D DVE 特技：

点击 Matrox 3D DVE旁边的三角，扩展属性清单。

·Transform 使用此控制添加多种自定义设置，如位置、尺寸和旋转。
要了解更多信息，见 34 页 “自定义素材”。

·Border Settings 可以给素材加一个边框或是柔边。

- Border Outside Softness 可以调整素材边缘的柔度或是外部的
边框。柔度越高，边缘越柔和。

- Border Type 选择您需要的边框类型 （None、Flat、Gradient
或 Alpha Edge）。点击右边的三角，扩展边框类型清单。

注：Alpha Edge边框类型仅用于有 alpha 键的图文。

- Border Width 使用此控制同时在 X 轴和 Y 轴上调节边框。值越高
边框越宽。如果您不选 Fixed Aspect Ratio，您可以单独调节每个
轴。

点击此处选择
边框类型
，设置 Adobe Premiere Pro 实时特技
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- Border Width X 使用此控制在 X轴上调节边框。值越高边框越宽。

- Border Width Y 使用此控制在 Y轴上调节边框。值越高边框越
宽。

- Border Inside Softness 设置边框内边缘的柔度。柔度越高，
边缘越柔和。

- Border Outside Color 使用颜色选择器或是吸管选择您需要的
边框颜色，如果您选择了 Gradient作为边框类型，这个钮控制边
框的外边缘的颜色。

- Border Outside Transparency 设置边框的透明度，如果您选择
了 Gradient作为边框类型，这个钮控制边框的透明度。值的范围
为不透明 （0）到全透明 （100）。

注：以下两种属性 （Border Inside Color 和 Border Inside 
Transparency）只在您选择了 Gradient作为边框类型时才可用。

- Border Inside Color 使用颜色选择器或吸管设置内边框的颜
色，边框的颜色将从内到外渐变。

- Border Inside Transparency 设置边框内部的颜色的透明度。

- Round Corner Size 令边框的角成为圆角。

- Corner Point Offset 可以移动边框的顶点，这样您可以创建不
同形状的 3D DVE。负值令顶点向素材的中心移动，正值向远离中心
的方向移动。

·Crop 裁剪素材的边缘，要了解详情，见 37 页 “裁剪特技”。
制作 3D DVE 特技
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制作四角镜框贴图特技
Matrox 四角镜框贴图特技可以将一个视频或是图文的几个点固定在下面
一层的素材上，即使下层的素材变形也没有关系。您可以使用这个特技将
一段素材放在另一个画面里的电视机屏幕上播放。

要设置 Matrox 四角镜框贴图特技：

点击 Matrox 4-corner Pin 旁边的三角，扩展属性清单。

·Top Left 和 Top Right Corner 使用些控制水平和垂直移动素材的
左上角和右上角的点。

·Bottom Left和 Bottom Right Corner 使用些控制水平和垂直移动
素材的左下角和右下角的点。

提示：您可以方便地将素材的每个顶点直接放在 Program 监示器中。
步骤如下：点击 Effect Controls面板里 Matrox 4-corner Pin 旁
边的 Transform钮 （ ） 。Program 监示器里素材的每个顶点上
的都出现一个光标。拖动这些光标调整素材的位置。

·Edge Softness 可以给素材加柔边。

·Crop 裁剪素材的边缘，要了解详情，见 37 页 “裁剪特技”。

·Preview Settings 有以下选项可以预览特技：

- Show Cursors 只在视频监示器上显示，素材的每个角显示为一个
钻石形状的光标。这些光标可以帮助您精确地确定每个顶点的位
置。每个顶点的颜色不同：

• 左上角：红色

• 右上角：绿色

• 左下角：蓝色

• 右下角：橙色

- Show Color Frame Only 显示一个半透明的形状，代表需要加四
角镜框贴图特技的素材。这在制作加了 alpha 键的图文时很有用，
您需要看到素材的边缘。

- Color 要更换显示颜色，使用颜色选择钮或是吸管。
，设置 Adobe Premiere Pro 实时特技
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提示：Show Color Frame Only选项是用来辅助制作四角镜框贴
图特技的。但是您可以用它制作一个独特的灯光特技，如制作聚光
灯效果。
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制作模糊 /软聚焦特技
Matrox 模糊软聚焦特技让您创作独特的特技或模仿照相机散焦效果。

要设置 Matrox 模糊 /软聚焦特技：

点击 Matrox Blur/Soft Focus旁边的三角，扩展属性清单。 

·Blur Amount 使用此控制改变素材的模糊程度。

·Source Blend Factor 使用此控制将原图像叠加在加了模糊特技的
素材上。设为 0值是只显示加了模糊特技的效果，设置为 100 只显示
原图像效果。任何中间值显示两种效果的混合效果，即软聚焦效果。

·Lock Colors 选择此选项按比例增加或是减少红、绿和蓝色的增益。
比如，您在 Red Color Gain上做的任何调节都将用于绿色和蓝色的
增益。

·Red Color Gain 增加或减少图像中的红色。

·Green Color Gain 增加或减少图像中的绿色。

·Blue Color Gain 增加或减少图像中的蓝色。

·Crop 裁剪素材的边缘，要了解详情，见 37 页 “裁剪特技”。

注：如果您使用的是高清素材，视您的设置不同，模糊 /软聚焦特技
有可能需要生成。
，设置 Adobe Premiere Pro 实时特技
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色键特技
您可以使用 Matrox 实时插件制作色键或色键阴影特技，令前景视频的某
些部分变得透明，可以看到背景素材。

在以下色键特技例子中，前景图片是一个女人坐在绿幕前的素材，背景是

一段沙丘素材：

使用色键抠掉前景图像的绿幕，绿幕部分变成透明，相应的背景部分就透
过来了，合成画面如下：

重要：色键阴影特技可以在特技里精确调整阴影。如果您给素材只加色键
特技，没有其它特技时，最好使用色键阴影特技。但如果您还要在加了色
键特技的素材上加其它特技，使用不含阴影控制的色键特技效果会比较
好。比如，如果您想给色键特技再加一个 DVE，您应该使用色键特技，而
不是色键阴影特技。

前景图像 背景图像

+

色键处理过的画面

=

色键特技
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制作色键或是色键阴影特技
要设置 Matrox 色键或色键阴影特技，点击 Matrox Chroma Key/Matrox 
Chroma Key Shadow旁边的三角扩展属性清单：

·Graphical 使用图来控制色键，还可制作自动键。

- Map 可选择包含颜色频谱的方块中的键颜色。

- Plot 显示素材中的颜色柱状图，选择您需要加键的颜色。

- Show Key 点击此钮显示用于创建键特技的遮片。此钮令您可以进
一步调节键。比如，当您显示遮片时，您的键颜色 （如绿色）显示
为黑色，不透明的部分显示为白色。如果您注意到一些您需要加键
的白色点，您可以调节键控制，直到白色点消失为止。

- Auto Key 点击此钮自动给当前帧最常用的颜色（除了灰色外）加
键。

要了解如何在图形中选择键颜色或是制作自动键，见 69 页 “使用
色键图修改键颜色并制作自动键”。
，设置 Adobe Premiere Pro 实时特技
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注：您必须扩展 Graphical 属性，在调整色键控制时才可以看到指示
器。

·Hue 用此键沿颜色频谱图的边缘旋转指示器，以选择需要加键的颜

色。

·Aperture 使用此键加宽或是缩窄指示器的节距，以增加或是减少您

需要加键的颜色范围。

·Saturation 使用此控制选择有某个特定色饱和度值的颜色。淡颜色

的色饱和度较低，靠近频谱图的中心，鲜艳的颜色的色饱和度较高，

离频谱图中心较远。因为淡颜色的色饱和度低，比起鲜艳的颜色来说，

更难抠像一些。

·Saturation Threshold 使用此控制按比例增加或是减少饱和度范围

外的区域，控制与 Saturation值多接近的像素将被抠掉。

比如，给前景图像加了一个色键特技，而前景图像中有些暗的部分您
需要保留，这些区域在加了键以后有可能变成半透明的。通过调节
Saturation Threshold，您可以消除这些暗区域的键颜色，令它们
变成完全不透明。

·Softness 通过混合前景与背景的图像软化键的边缘。这令前景图像

部分透明，而不是完全透明或不透明。

·Spill Removal 使用此控制去掉前景抠像周围的残色。这些残色通

常是由于纯色背景通过灯光反射到前景人物上造成的。Spill 

Removal将有残色的部分的键颜色替换为频谱图相反的颜色，令此区

域的颜色恢复自然。

·Chroma Suppression 使用此控制去掉抠像颜色再在前景画面上的颜

色。比如，如果抠像的颜色是纯绿色，前景有一个人，人的皮肤有可

能被染成绿色。您可以调节 Chroma Suppression使用频谱里相反的

颜色来去掉绿色，令肤色达到自然颜色。

注：以下属性（Luminance和 Shadow Suppression）只有色键阴影
特技里有。

·Luminance 使用此控制调节阴影的亮度。负值增加阴影的亮度，正值

减少阴影的亮度。

·Shadow Suppression 使用此控制令素材的阴影不明显。值越高，阴

影越不明显。

·Mask 可以在特技上加一个遮蔽。要了解详情，见 39 页 “给素材添加

一个遮蔽”。
制作色键或是色键阴影特技
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·Transparent Outside Mask 选择此选项给遮蔽外的区域加一个透

明度。您可以定义一个遮蔽区域，在此区域加键，遮蔽区域外显示下

一层的图像。要了解详情，见 39 页 “给素材添加一个遮蔽”。

·Invert Key 选择此控制反转键选择，令您得到与原来的键相反的效

果。

·Show Key as Output 选择此控制显示用于创建键特技的遮片。令您

可以进一步精确调节您的键。比如，当您显示遮蔽时，您的键颜色

（如绿色）显示为黑色，不透明的部分显示为白色。如果您注意到一些

您需要加键的白色点，您可以调节键控制，直到白色点消失为止。
，设置 Adobe Premiere Pro 实时特技
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使用色键图修改键颜色并制作自动键
要直接在色键图上修改您的键颜色或是制作一个自动键，点击 Graphical 
属性旁边的三角，扩展它：

·Map 当您首次扩展 Graphical属性时，这是默认显示。您可以拖动
颜色频谱图上的控制，将显示器拖动到方式块里的不同部分，调节
Hue、 Aperture、Saturation和 Saturation Threshold。

注：只在您创建色键阴影特技时，此图才会包括亮度频谱图。您可以拖动
亮度频谱图里的控制调节 Luminance。

·Plot 点击此钮，以图形显示当前帧的亮度和色度柱状图。您可以拖
动色度柱状图的控制，将指示器移动到不同区域，以调节 Hue、
Aperture、 Saturation和 Saturation Threshold。每种亮度值表
示为一条垂直线。长一点的线表示此亮度值的像素多一些。

3 2 1

4

4

5

1 色调 2 色饱和度 3 色饱和度
门限

4 节距 5 亮度
制作色键或是色键阴影特技
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注：只有您在创建一个色键阴影特技时 Plot图才有亮度柱状图。您
可以在这个图中拖拉控制，调节 Luminance。

·Show Key 点击此钮显示用于创建键特技的遮片。此钮令您可以进一
步调节键。比如，当您显示遮片时，您的键颜色 （如绿色）显示为黑
色，不透明的部分显示为白色。如果您注意到一些您需要加键的白色
点，您可以调节键控制，直到白色点消失为止。

·Auto Key 点击此钮自动给当前帧最常用的颜色 （除了灰色外）加
键。选择 Auto Key影响 Hue、Aperture、Saturation和
Saturation Threshold。如果您的素材键的颜色很均匀，使用 Auto 
Key会得到效果很好的色键。反之，您可以使用吸管选择您需要的颜
色。

您有两种方法使用吸管：

- 点击吸管钮，并点击您需要加键的颜色。

- 点击吸管钮，在素材上包含您要选择的颜色的部分点击并拖拉鼠
标，创建一个矩形区域。

4

4

1

2

3

5

1 色调 2 色饱和度 3 色饱和度
门限

4 节距 5 亮度

吸管
，设置 Adobe Premiere Pro 实时特技
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·Indicator 点击此钮显示或隐藏指示器。

·Handles 点击此钮显示或隐藏指示器控制。
制作色键或是色键阴影特技



72

第 3 章
制作结晶特技
Matrox 结晶特技有多种模板供选择，令画面看上去像是水晶制作的。

要设置 Matrox 结晶特技：
点击 Matrox Crystallize 旁边的三角，扩展属性清单。

• Select Shape 点击当前模板右边的按钮，观看可用的结晶模板清单。

• Smoothness 设置结晶模板的颜色的光洁度。值越高颜色越光洁。

• Crystal Opacity 设置结晶的不透明度。从完全透明 （0）到完全不
透明 （100）。

• 结晶化 Alpha 通道 起用结晶特技的 alpha 通道，这样即使在加了去除
锯齿边功能的字幕或是 DVE 特技上都可以看到结晶。这个功能的默认
设置是起用，如果您发现结晶特技令您的字幕难以辨认，可以不选这
个功能。

注：Crystallize Alpha Channel 只在源素材或是加到源素材的特技上
有一个 alpha 通道信息时可用。比如，如果您在素材上加了一个没有
alpha 通道键信息的结晶特技，并用 Adobe 的 Motion 特技缩小画面，
在素材的边缘部分将看不到结晶特技的效果，因为 Motion 特技是最后
加的特技，而且没有 alpha 通道键信息可用来制作结晶化效果。但如
果您在同一个素材上加了 Matrox 3D DVE，再加结晶特技，您可以看到
结晶效果的边缘，因为 Matrox 3D DVE 特技包括了 alpha 信息。

• Mask Settings 可以选择一个遮蔽模板并调节透明度设置，以定义您
可以看到结晶特技的区域。

- Enable Mask 选择此选项起用遮蔽。

- Select Shape 点击当前模板右边的钮观看遮蔽模板清单。

点击此处选择
一个新模板

点击此处选择
一个新模板
，设置 Adobe Premiere Pro 实时特技
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- Shape Transparency 选择遮蔽及周围区域的透明度。默认设置为
（0），遮蔽为全不透明，周围区域为透明。将滑动指针向左拖增加
遮蔽的透明度，结晶特技效果变得不明显。将滑动指针向右拖减少
遮蔽周围的透明度，令遮蔽外面区域的结晶效果更明显。

- Outside Transparency 设置遮蔽外部区域的透明程度。

注：只有您使用自定义控制将遮蔽的尺寸缩小、移动或是旋转遮蔽
后，遮蔽不覆盖整个屏幕时，才可使用 Outside Transparency。 

- Softness 给遮蔽的边缘加上结晶特技。

- Invert Mask 如果您希望反转遮蔽的不透明和透明的部分，选择此
键。

- Apply Crop to Video Only 如果您想缩小遮蔽，以放进被裁剪了的
素材里，选择此项。如果您不选择此项，遮蔽将按照您对素材的裁
剪程度被裁剪。

- Transform 使用此控制添加或是修改遮蔽的多项自定义设置。如位
置、尺寸和旋转。要了解更多信息，见 34 页 “自定义素材”。

• Crop 裁剪素材的边缘。要了解更多信息，见 37 页 “裁剪特技”。
制作结晶特技
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制作镜头璇光特技
Matrox 镜头璇光特技模拟由于强光进入照相机镜头所导致的独特的反射效
果。有多种镜头璇光模板供选择。

要设置 Matrox 镜头璇光特技：
点击 Matrox Lens Flare 旁边的三角，扩展属性清单。

• Light Source Position

- Position X & Y 设置光源在水平和垂直坐标轴上的位置。光源产生
的折射将按此位置移动。 

- Position Z 设置光源的纵向深度位置

提示：您可以直接在 Program 监示器窗口里方便地调整光源位置。点
击 Effect Controls面板里 Matrox Lens Flare旁边的 Transform 钮 
（ ） 。Program 监示器里出现一个叉丝，拖动叉丝，确定光源的
位置。

·Center Position

- Position X 设置镜头璇光在水平坐标轴上的位置。

- Position Y 设置镜头璇光在垂直坐标轴上的位置。

• Select Shape 点击当前模板右边的按钮，观看可用的镜头璇光特技
模板。

·Global Settings

- Scale （X， Y） 使用此控制缩小或放大镜头璇光。全屏尺寸为
100%，您可以缩小到 0% 或放大到 1000%。但注意，放大素材后，画
面有可能变得模糊。您可以单独调整每个方向的尺寸控制，如果您
选择了 Fixed Aspect Ratio，只要调节一个坐标轴，另一个也跟着变
化。您可以在 X和 Y 轴上输入镜头璇光变化百分比，相应调整高度
和宽度。

- Intensity 设置折射光的不透明度。全透明为 0，不透明为 100。

点击此处选
择一个新模
板

，设置 Adobe Premiere Pro 实时特技
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- Enable Alpha 选择此项起用镜头璇光特技的 alpha 功能，这样即使
是在素材的透明 （抠像）部分仍是看得到镜头璇光。

• Flare Settings 调节此设置改变璇光 （通常是最亮的点）的效果。

注：虽然大多数的镜头璇光模板里有璇光，有些没有。如果这个模板
没有璇光，就不会有这些设置。

- Size 设置璇光的尺寸。

- Intensity 设置璇光的不透明度。全透明为 0，不透明为 100。

- Color 设置璇光的颜色。

·Crop 裁剪素材的边缘。要了解更多信息，见 37 页 “裁剪特技”。
制作镜头璇光特技
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亮度键特技
您可以使用 Matrox 实时插件制作亮度键，令前景视频按图像的亮度将某
个部分变得透明，可以看到背景素材。

在以下亮度键特技例子中，两段素材合成在一起，制作出两个牛仔穿过大

火的效果。我们的前景素材是一个火环，背景是黑色的，背景素材是两个
骑着马的牛仔：

使用亮度抠像去掉前景图像黑色部分的某一亮度，这部分变成透明，相应
的背景部分就透过来了，合成画面如下：

前景素材 背景素材

+

亮度键处理过的画面

=

，设置 Adobe Premiere Pro 实时特技
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制作亮度键特技
要设置 Matrox 亮度键特技，点击 Matrox Luma Key旁边的三角扩展属性
清单：

·Graphical 允许您在调节属性设置时通过图形看到画面的变化。您可
以直接在图上调整亮度键，选择您需要加键的亮度。要了解更多信息，
见 78 页 “使用亮度键图”。

·Transparency 使用此控制设置键特技的透明度。高一点的值表示透
明度高一些。比如，Transparency 为 100 表明前景加键的部分的完
全透明，下一层画面可见。

·Low Clip 使用此控制选择较低的亮度加键。Low Clip设置为 0表
示黑，设置为 255 表示白。中间的设置为不同程度的灰，从很暗到很
亮的灰。

·Low Gain 使用此控制，按您在 Low Clip控制中设置的值决定您需
要部分影响的亮度值。增加 Low Gain设置，更多亮度值的像素将变得
部分透明，以制作一个边缘柔和的键。

Low Gain设置为 100 为最宽的范围，柔度为最大。相反，设置为 0 则
创建一个边缘很硬的键，亮度值要么完全透明或完全不透明。您可以
将 Low Gain控制理解为前景图像较暗部分的 “从透明到不透明”的
范围的控制。

·High Clip 此控制与 Low Clip相似，只是使用此控制选择给高亮度
的区域加键。
制作亮度键特技
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·High Gain 此控制与 Low Gain相似，区别只是在于您使用此控制，
按在 High Clip控制中设置的值决定您需要部分影响的亮度值范围。
您可以将 High Gain控制理解为对画面较亮的区域 “从不透明到透
明”的受影响程度的指标。

注：您使用 Low Clip和 Low Gain控制设置的值视您的 High Clip 
和 High Gain控制而定，反之亦然。这将防止高和低控制都在同一样
的值上加键。

·Mask 可以在特技上加一个遮蔽。要了解详情，见 39 页 “给素材添加
一个遮蔽”。

·Transparent Outside Mask 选择此选项给遮蔽外的区域加一个
透明度。您可以定义一个遮蔽区域，以在此区域加键，只显示遮
蔽外的背景图像。要了解详情，见 39 页 “给素材添加一个遮蔽”。

·Invert Key 选择此控制反转键选择，令您得到与原来的键相反的效
果。

·Show Key as Output 选择此控制显示用于创建键特技的遮片。令您
可以进一步精确调节您的键。比如，当您显示遮片时，完全透明的部
分显示为黑色，不透明的部分显示为白色。如果您注意到一些您需要
加键的白色点，您可以调节键控制，直到白色点消失为止。

使用亮度键图
亮度键图包含了亮度频谱图和亮度吸管。您可以在亮度频谱图里拖动控
制，以调节 Transparency、Low Clip、Low Gain和 High Gain属性。

您可以通过调节 Low Clip和控制选择需要加键的亮度值，或者您可以使
用亮度吸管自动选择需要加键的亮度值。您有两种方法使用吸管：

- 点击吸管钮，并点击您需要加键的亮度。

- 点击吸管钮，在素材上包含您要选择的亮度的部分点击并拖拉鼠
标，创建一个矩形区域。

吸管 
，设置 Adobe Premiere Pro 实时特技
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您还可以使用 Low Gain、High Gain和 Transparency控制调节键的柔
度。所有这些调节影响亮度选择器的形状和尺寸，如下图所示：

·Plot 点击此钮观看亮度频谱柱状图。图像中每个亮度值在柱状图中
表现为一条线，长一点的线表示有更多像素有此亮度值。您可以在亮
度频谱图中拖动控制调节 Transparency、Low Clip、Low Gain和
High Gain属性。您做的所有调节都将影响 Luma Plot中的亮度选择
器的形状和尺寸。

HIGH GAINLOW GAIN

TRANS

LOW CLIP HIGH CLIP
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制作遮蔽特技
Matrox 遮蔽特技令您可以选择几十种柔边的切出的形状，可以将一个素材
叠加到另一个素材上。

要设置 Matrox 遮蔽特技：

点击 Matrox Mask旁边的三角，扩展属性清单。

·Select Shape 点击当前模板右边的钮观看遮蔽模板清单。

·Shape Transparency 选择遮蔽及周围区域的透明度。默认设置为

（0），遮蔽为全不透明，周围区域为透明。将滑动指针向左拖增加遮

蔽的透明度。将滑动指针向右拖减少遮蔽周围的透明度。

·Outside Transparency 设置遮蔽外部区域的透明程度。

注：只有您使用自定义控制将遮蔽的尺寸缩小、移动或是旋转遮蔽

后，遮蔽不覆盖整个屏幕时，才可使用 Outside Transparency。当

加了 Outside Transparency时，Shape Transparency设置整个素

材的透明度。

·Softness 给遮蔽加上柔边。

·Invert Mask 如果您希望反转遮蔽的不透明和透明的部分，选择此

键。

·Apply Crop to Video Only 如果您想缩小遮蔽，以放进被裁剪了

的素材里，选择此项。如果您不选择此项，遮蔽将按照您对素材的裁

剪程度被裁剪。

点击此处选
择新模板
，设置 Adobe Premiere Pro 实时特技
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·Transform 使用此控制添加或是修改遮蔽的多项自定义设置。如位

置、尺寸和旋转遮蔽。要了解更多信息，见 34 页 “自定义素材”。

·Crop 裁剪素材的边缘。要了解更多信息，见 37 页 “裁剪特技”。
制作遮蔽特技
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制作遮蔽模糊特技
使用 Matrox 遮蔽模糊特技可以在画面上感兴趣的部分加一个遮蔽和模糊
特技，达到突出这个部分的效果。有多个遮蔽模板供选择。

要设置 Matrox 模糊遮蔽特技：

点击 Matrox Mask Blur 旁边的三角，扩展属性清单。 

• Blur Settings 可调节素材的模糊程度。

- Red， Green、Blue和 Alpha Blur Amount 使用这些控制调节素
材里每种颜色和 alpha 的模糊程度。比如，您可以选择只在素材的
红色部分加模糊效果。Alpha Blur Amount只在素材有 alpha 通道
时才可用。

- Lock Channels 使用此控制给所有通道加同样的模糊。当您在调
节 Red Blur Amount，同样的设置会加在其它通道上。

• Color Gain Settings 调节素材里模糊区域中的颜色强度。

- Red、Green和 Blue Color Gain 使用这些控制单独精确调节素
材里某个特定颜色的强度。比如，您可以增加 Red值，只增加模糊
部分里红色的强度。

- Lock Channels 使用此控制给所有通道加同样的颜色增益。当您
在调节 Red Color Gain，同样的设置会加在其它通道上。

• Mask Settings 可以选择遮蔽模板并调节特技的透明度设置。

- Select Shape 点击当前模板右边的钮观看遮蔽模板清单。

- Shape Transparency Shape Transparency 选择遮蔽及周围区
域的透明度。默认设置为 （0），遮蔽为全不透明，周围区域为透
明。将滑动指针向左拖增加遮蔽的透明度，模糊程度下降。将滑动
指针向右拖减少遮蔽周围的透明度，模糊程度增加。

- Outside Transparency 设置遮蔽外部区域的透明程度。 

注：只有您使用自定义控制将遮蔽的尺寸缩小、移动或是旋转遮蔽，
遮蔽不覆盖整个屏幕时，才可使用 Outside Transparency。当加了
Outside Transparency时，Shape Transparency设置整个素材的
透明度。

点击此处选
择新模板
，设置 Adobe Premiere Pro 实时特技
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- Softness 令遮蔽的边缘模糊。

- Invert Mask 如果您希望反转遮蔽的不透明和透明的部分，选择
此键。

- Apply Crop to Video Only 如果您想缩小遮蔽，以放进被裁剪
了的素材里，选择此项。如果您不选择此项，遮蔽将按照您对素材
的裁剪程度被裁剪。

·Transform 使用此控制添加或是修改遮蔽模糊特技的多项自定义设
置。如位置、尺寸和旋转遮蔽。要了解更多信息，见 34 页 “自定义素
材”。

·Crop 裁剪素材的边缘。要了解更多信息，见 37 页 “裁剪特技”。

注：如果您制作的是高清项目，视您的项目的视频格式不同，模糊遮
蔽特技有可能需要生成。
制作遮蔽模糊特技
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第 3 章
制作遮蔽马赛克特技
使用 Matrox 遮蔽马赛克特技可以在画面上感兴趣的部分加一个遮蔽和马
赛克特技，达到突出这个部分的效果。有多个遮蔽模板供选择。

要设置 Matrox 遮蔽马赛克特技：

点击 Matrox Mask Mosaic 旁边的三角，扩展属性清单。 

• Mosaic Settings 调节马赛克块的大小和马赛克特技颜色的锐度。

- Block Width和 Block Height 使用这些控制设置特技的马赛克
块的宽度和高度。如果您选择了 Fixed Aspect Ratio，您只需要
调节宽高，高度会按比例变化。

- Color Sharpness 调节特技里每个马赛克的锐度。每个块会使用
该块下层图像里主要的颜色 （而不是平均颜色）。

• Mask Settings 可以选择遮蔽模板并调节特技的透明度设置。

- Select Shape 点击当前模板右边的钮观看遮蔽模板清单。

- Shape Transparency 选择马赛克块及周围区域的透明度。默认
设置为 （0），马赛克块为全不透明，周围区域为透明。将滑动指针
向左拖增加马赛克块的透明度，马赛克特技明显程度下降。将滑动
指针向右拖减少马赛克块周围的透明度，马赛克特技明显程度上
升。

- Outside Transparency 设置遮蔽外部区域的透明程度。

注：只有您使用自定义控制将遮蔽的尺寸缩小、移动或是旋转遮蔽，
遮蔽不覆盖整个屏幕时，才可使用 Outside Transparency。当加了
Outside Transparency时，Shape Transparency设置整个素材的
透明度。

- Softness 给马赛克遮蔽加上柔边。

- Invert Mask 如果您希望反转遮蔽的不透明和透明的部分，选择
此键。

- Apply Crop to Video Only 如果您想缩小遮蔽，以放进被裁剪
了的素材里，选择此项。如果您不选择此项，遮蔽将按照您对素材
的裁剪程度被裁剪。

点击此处选
择新模板
，设置 Adobe Premiere Pro 实时特技
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·Transform 使用此控制添加或是修改遮蔽马赛克特技的多项自定义设

置。如位置、尺寸和旋转遮蔽。要了解更多信息，见 34 页 “自定义素

材”。

·Crop 裁剪素材的边缘。要了解更多信息，见 37 页 “裁剪特技”。
制作遮蔽马赛克特技
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第 3 章
制作移动 /缩放特技
Matrox 移动 / 缩放特技可以将素材放在二维空间的任何位置，并可以缩放

素材，同时实时制作柔边。

注：移动 /缩放特技在制作画中画特技时提供清晰的画面。但如果您需要

旋转素材，您必须按 60 页 “制作 3D DVE 特技”所述使用 3D DVE 特技。

要制作 Matrox 移动 /缩放特技：

点击 Matrox Move & Scale 旁边的三角，扩展属性清单。

·2D Transform

- Position （X， Y） 使用此控制将素材放在 x （水平）和 y （垂

直）坐标轴上。0.0 时素材的中心点在屏幕中心位置上，所有的距

离都是从这点开始计算。您可以输入正值或负值左右 （x）或上下

（y）移动素材。

- Scale （X， Y） 使用此钮调整素材大小。全屏是 100%，可以将素

材缩成 0% 或放大成 100%。注意，素材放大后，分辨率会降低。可

独立调整各尺寸控制，或如果选择了 Fixed Aspect Ratio，只需

要调节一个 x 轴，其它轴自动按比例改变。调节 x和 y 轴的百分

比，分别改变素材宽度和高度。

- Anchor Point X & Y 设置原点，您由此点开始在 x （水平）和 y

（垂直）坐标轴上缩放素材。

• Edge Softness （X， Y） 在 x（水平）或是 y（垂直）坐标轴上加柔

边。可独立调整各柔边控制，或如果选择了 Fixed Aspect Ratio，

只需要调节一个 x轴，其它轴自动按比例改变。柔边的值越高，边缘

越柔和。
，设置 Adobe Premiere Pro 实时特技
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- Nonlinear Softness 选择此选项令柔边的边缘不明显。起用此选项

令柔边的效果和 Matrox 3D DVE 特技的效果相似。

• Crop 裁剪素材的边缘。要了解更多信息，见 37 页 “裁剪特技”。
制作移动 / 缩放特技
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第 3 章
制作怀旧电影特技
Matrox 怀旧电影特技可以在素材上加上噪波、尘粒、抖动、闪烁和条纹
等，制作怀旧电影的效果 。

要制作 Matrox 怀旧电影特技：
点击 Matrox Old Movie 旁边的三角，扩展属性清单。

• Random Artifact Generator 调节此设置改变在画面加的干扰失真的

位置。基于您设置的值，干扰是基于您设置的值随机发出的。比如，

如果您发现画面的条纹干扰总在一个位置，您可以使用这个设置移动

它们。

 tBorder Settings

- Round Corner Size 令素材的边角是圆的。

- Softness 通过拖动滑动指针或是输入一个百分数，调节素材的边

缘的柔度。值越高边缘越柔和。

• Preprocessing 此控制允许您隔离一个通道，单独处理这个通道里的
的特技的黑白值。比如，如果只需要调节红色通道的黑和白值，选择
Red Only 模式。

- Enable Preprocessing 选择此选项起用预处理。起用此选项令您的

素材变成黑白的。

注：调节 Color Gain 和 Color Addition 控制将改变素材的颜色。如果
您希望素材仍保留为黑白，从 Color Gain 和 Color Addition 中选择
Lock Colors。

- Mode 选择您想用于处理的通道。点击右边的三角扩展清单。

• Red Only 使用红色通道。

• Green Only 使用绿色通道。
，设置 Adobe Premiere Pro 实时特技
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• Blue Only 使用蓝色通道。

• Alpha Only 使用 alpha 通道。

• Luma 使用亮度值。

• Oversaturated Luma 只使用过饱和的亮度值。

·Noise

- Noise Pattern 选择噪波模板。点击右边的按钮观看可用的模板。

- Lifetime 设置在噪波模板在移动到另一个随机位置时，保持不动
的最多的帧数。

- Opacity 设置噪波模板的不透明度。值为全透明 （0）到全不透明
（100）。

- Color 设置噪波颜色。

·Dust

- Dust Pattern 选择尘土模板。点击右边的按钮观看可用的模板。

- Amount 设置在某一时间屏幕上可以看到的尘粒的数目。

- Lifetime 设置在尘土模板在移动到另一个随机位置时，保持不动

的最多的帧数。

- Opacity 设置尘土模板的不透明度。值为全透明 （0）到全不透明

（100）。

- Color 设置尘土颜色。

- Fixed Particle

• Display Fixed Particle 如果您需要一颗尘粒总停留在画面的一

个位置上，选择此项。

• Particle Number 选择您需要停留在画面上不动的尘粒，每颗尘

粒由一个值代表。

• Position X 设置固定尘粒在水平坐标轴上的位置。

• Position Y 设置固定尘粒在垂直坐标轴上的位置。

点击此钮观
看噪波模板

点击此钮观
看尘土模板
制作怀旧电影特技
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第 3 章
·Streak

- Streak Pattern 选择条纹模板。点击右边的按钮观看可用的模板。

- Amount 设置在某一时间可以看到的最多的条纹数目。

- Opacity 设置条纹模板的不透明度。值为全透明 （0）到全不透明

（100）。

- Color 设置条纹颜色。

·Jitter

- Manual Control 选择此选项禁用 Probability，并只使用 Offset 手

动控制抖动的幅度。

- Probability 指定出现抖动的频率。值越高出现抖动的可能性越

大。

- Offset 指定抖动向上移的幅度。

- Distance Between Frames 设置在当前帧和下一帧的抖动之间的垂直

方向的距离。值越高，两帧之间的抖动的距离越远。

·Flicker

- Manual Control 选择此选项只使用 Highest Intensity 控制手动控

制闪动出现的时间。起动此选项将禁用其它闪动控制。

- Frequency 指定出现的闪动的频率。值越高，您看到的闪动就越

多。

- Lowest Intensity 设置最低亮度值，在闪动出现时，亮度此值起向

Highest Intensity 值由暗向亮渐变。值越低起始亮度越暗。比如，

如果您希望您的闪动从完全黑过渡到普通亮度，将 Lowest 

Intensity 设置为 0%，将 Highest Intensity 设置为 100%。

- Highest Intensity 设置闪动的亮度最高值。

注：如果您起用了 Manual Control，您可以通过在多个亮度电平值上

创建关键帧使用 Highest Intensity 控制闪动。

- Randomize 指定闪动出现的随机程度。比如，在 0% 时，没有随机

出现的闪动，闪动出现得很有规律。值越高，随机出现的闪动越

多。

点击此钮观
看条纹模板
，设置 Adobe Premiere Pro 实时特技
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• Color Gain 和 Color Addition （Red， Green， Blue） 您可以使用在
Color Gain 和 Color Addition 下的控制单独精确调节图像的颜色。要
按比例增加或减少红、绿和蓝值，选择 Lock Colors。

- Color Gain 下的 Red、Green 和 Blue 控制可以增加或减少您的图像
里的某个特定颜色的强度。比如，增加 Red 值只会增加图像里红色
的强度，不会影响其它颜色。

- Color Addition 通过输入 Red、Green 或 Blue 值调节整个图像的颜
色。比如，增加 Red 值增加整个图像的红色值。

·Crop 裁剪素材的边缘。要了解更多信息，见 37 页 “裁剪特技”。
制作怀旧电影特技
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第 3 章
制作卷页特技
Matrox RT.X2 卷页特技为真正三维特技，卷页的两面都有高质量的视频画
面和逼真的光泽。您可以在三维空间中控制卷页位置、旋转程度、大小并
缩放卷页。还可以控制卷页的边缘柔度。您还可以在图文上制作卷页，加
强画面效果。

要设置 Matrox 卷页特技：

点击 Matrox Page Curl旁边的三角，扩展属性清单。 

·Page Curl

- Fold Type 您可以选择是 Page Peel（翻页）还是 Page Roll
（卷页）类型的卷页 （此设置影响整段特技）。

- Fold Angle 设置卷页的角度，单位为度。或者您可以设置卷页的
圈数。

- Curl Radius 决定卷页的松紧程度。比如，半径为 0是最紧的卷
页，值越高越松。

- Progression 设置在任意帧卷页的进程。要看到卷页的进程，您
至少需要加两个关键帧。要创建一个标准的卷页特技，将第一帧的
Progression 设置为 0%，最后一帧的 Progression设置为 100%。
要了解更多关于关键帧的信息，见您的 Adobe Premiere Pro 文件。

- Edge Softness 给卷页加上柔边。

- Curl Softness 给正在卷的部分加一个柔边。

注：如果您在自定义控制中调整尺寸或是旋转设置，您将不会看到
Curl Softness的效果。
，设置 Adobe Premiere Pro 实时特技
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·Highlight 有一条白色亮线，可以突出卷页。以下为调整这条亮线所
需的设置：

- Position 设置高亮显示部分在卷页上的位置。

- Intensity 设置高亮显示的明亮程度，单位为百分数。

·Shadow Intensity 设置卷页阴影的阴暗程度，单位为百分数。

·Transform 可修改多项自定义设置，如改变素材的尺寸、位置和旋转
素材。要了解详情，见 34 页 “自定义素材”。

·Crop 裁剪素材的边缘。要了解更多信息，见 37 页 “裁剪特技”。
制作卷页特技
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第 3 章
制作摇移特技
Matrox 实时摇移滤镜特技可以方便地将素材从一个宽高比转换成另一个宽
高比。截取画面也变得轻而易举，因为现在您可以看到整段素材和您需要
截取的部分，跟踪屏幕上需要截取的部分的移动，做出准确判断。

您可以使用 Matrox 摇移特技将素材转为不同宽高比。要做到这一点，您
需要给嵌套的序列加摇移特技：

1 选择 File > New > Sequence。

2 输入新序列的名字，再点击 OK。

3 将您原来的序列从 Project面板中拖动到新序列里。

4 在新序列里加 Matrox 摇移特技。

5 按您的需要调节摇移设置。

要了解如何创建嵌套序列的更多详情，见您的 Adobe Premiere Pro 文件。

要设置 Matrox 摇移特技：

点击 Matrox Pan & Scan旁的三角，扩展属性清单。

·Source Aspect Ratio 使用此控制选择源素材的宽高比。您可以点
击右边的三角，扩展清单，并选择预定义的宽高比或是使用 Source 
Aspect Ratio 滑动指针选择一个自定义的宽高比。

·Destination Aspect Ratio 使用此控制选择您需要转换成的宽高
比。您可以点击右边的三角，扩展清单，并选择预定义的宽高比或是
使用 Destination Aspect Ratio 滑动指针选择一个自定义的宽高
比。

注：如果您制作的是高清素材，宽高比会总为 16:9。因此，如果您选
择 4:3 作为 Destination Aspect Ratio，您的素材将会变形。

·Scale 使用此钮按比例改变 （增加或减少）画面尺寸。
，设置 Adobe Premiere Pro 实时特技
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·Pan Position 令您可以移动画面中您感兴趣的部分。在使用
Global View 观看方式 （见下图）时，您会看到是在画面的哪一部
分。

·Enable Global View 选择此项在您使用 Pan Position选择的感兴
趣的部分加一个长方框。
制作摇移特技
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第 3 章
制作阴影特技
Matrox 阴影特技可以从任何包含键信息的素材源 （如带 alpha 通道的 DVE
和字幕）上打一个逼真的阴影。您可以调整阴影的颜色、位置、大小并旋
转阴影，以与投下的灯光相配。给阴影加上模糊特技可以模仿散光灯的效
果。

注：如果您制作的是高清项目，Matrox 阴影特技在与其它特技一起使用时
有可能需要生成。

要设置 Matrox 阴影特技：

点击 Matrox Shadow旁的三角，扩展属性清单。

重要：您的源素材或是加在素材上的特技必须有一样包括了 alpha 键信
息，才能创建阴影特技。比如，如果您将阴影特技加到一个没有 alpha 键
通道信息的素材上，再使用 Adobe 的 Motion 特技缩小画面尺寸，您将看
不到阴影，因为 Motion 特技是后来加上去的，而且没有 alpha 键信息以
创建阴影特技。但是，如果您给同样的素材加上 Matrox 3D DVE 特技，再
加阴影特技，您将会看到阴影，因为 Matrox 3D DVE 特技包含 alpha 信
息。

·Lock Colors 选择此选项锁定阴影上方和下方的角上的颜色和透明
度值。比如，您选择用于右上角阴影的颜色和透明度值将用于阴影的
所有 4 个角。

·Top Right Corner Color 使用此控制设置右上角的颜色。
，设置 Adobe Premiere Pro 实时特技
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·Top Right Corner Opacity 使用此控制设置右上角的不透明度。
值为全透明 （0）到全不透明 （100）。

·Top Left Corner Color 使用此控制设置左上角的颜色。

·Top Left Corner Opacity 使用此控制设置左上角的不透明度。值
为全透明 （0）到全不透明 （100）。

·Bottom Left Corner Color 使用此控制设置左下角的颜色。

·Bottom Left Corner Opacity 使用此控制设置左下角的不透明
度。值为全透明 （0）到全不透明 （100）。

·Bottom Right Corner Color 使用此控制设置右下角的颜色。

·Bottom Right Corner Opacity 使用此控制设置右下角的不透明
度。值为全透明 （0）到全不透明 （100）。

注：阴影角上的颜色是基于全屏加的。因此阴影角上的颜色有可能会
随着您的 DVE 的位置和尺寸变化。比如，如果您选择红色作为阴影右
上角的颜色，再将 DVE 缩小后放在屏幕的右上方，阴影的每个角都将
反射为红色，即使您有可能选择了其它颜色作为其它角的颜色。

·Shadow Softness 使用此控制设置阴影的柔度。值越高，阴影越柔
和。

注：Shadow Softness是从全屏的边缘上开始加的，因此 Shadow 
Softness 视您的 DVE 大小和位置不同有可能没那么明显。

·Blur 使用此控制给阴影加模糊效果。

·Camera Field of Vision 指定摄像机相对于阴影看到的视野。

·Camera Position X 绕 X 轴移动摄像机。

·Camera Position Y 绕 Y 轴移动摄像机。

·Camera Position Z 将摄像机拉近或是远离阴影。

·Transform 可以修改多项阴影的自定义设置，比如尺寸、位置和旋转
阴影。要了解更多信息，见 34 页 “自定义素材”。
制作阴影特技
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第 3 章
制作闪光特技
Matrox 闪光特技可以制作射过文字的光或是在画面物体上加上微光，使用
此特技可以令颊的文字看上去像是立体的效果。

要设置 Matrox 闪光特技：

点击 Matrox Shine 旁边的三角，扩展属性清单。

·Light Source

- Position X 水平方向移动光源位置。

- Position Y 垂直方向移动光源位置。

- Position Z 前后方向移动光源位置。

- Rotation 旋转光源。正值为逆时针旋转光源，负值为顺时针旋转
光源。

·Volume

- Length 设置光源发射的距离。正值光源向外射，负值光源向内
射。

- Mode 选择照射方式：Additive（叠加）或 Blend（混合）。点
击右边的三角，扩展清单。

• Additive 重复将一个闪光层加在另一个闪光层上，这样特技变
得更明亮。

• Blend 将闪光层混合在一起。这样制作平面文字的立体效果里
很有用。

- Precision 设置特技上在加多少个闪光层。值越高，特技效果越
干净清晰。

注：Precision 值越高，需要生成的时间越长。

- Start Opacity 设置离光源最近的射线的不透明度。值为从全透
明 （0） 到全不透明 （100）。

- End Opacity 设置离光源最远的射线的不透明度。值为从全透明
（0） 到全不透明 （100）。
，设置 Adobe Premiere Pro 实时特技
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• Preprocessing 这些控制令您可以隔离一个通道，将它作为闪光特
技的输入。比如，如果您可只在 alpha 通道上加闪光特技，您可以选
择 Alpha Only方式。

- Enable Preprocessing 选择此选项启用预处理。

- Mode 选择需要使用特技的通道。点击右边的三角扩展清单。

• Red Only 使用红色通道。

• Green Only 使用绿色通道。

• Blue Only 使用蓝色通道。

• Alpha Only 使用 alpha 通道。

• Luma 使用亮度值。

• Oversaturated Luma 只使用过饱和的亮度值。

- Threshold 使用此控制按比例增加或减少 Mode范围外的区域。
比如，如果您选择 Red Only方式，增加 Threshold将令真正鲜红
的区域才加闪光特技。

• Color Remapping 这些控制将给特技加一个颜色渐变。比如，您有
可能想使用包含了橙色、红色和白色的渐变制作一团正在烧得噼噼啪
啪的火的效果。

- Enable Color Remapping 选择此项启用颜色重映射。

- Gradient 选择一个颜色渐变模板。点击右边的按钮，从清单中选
择一个模板。您可以选择 Gradient Lower Boundary和 Gradient 
Upper Boundary控制选择您需要变化的颜色范围。

- Use Gradient Built-in Alpha 在使用含 alpha 通道的颜色渐变
图时选择此控制。

- Gradient Lower Boundary 选择颜色渐变的开始颜色，特技将由
此颜色起逐步变换成 Gradient Upper Boundary颜色。拖动滑动
指针，从颜色图中选择需要的颜色。比如，如果您选择您想从黑过
渡到白，起始颜色为半灰色，将指针设置为 50%。

- Gradient Upper Boundary 选择颜色渐变的结束颜色，特技将由
Gradient Lower Boundary颜色起逐步变换成此颜色。拖动滑动指
针，从颜色图中选择需要的颜色。比如，如果您选择您想从黑过渡
到白，结束颜色为深灰色，将指针设置为 10%。

• Noise 选择这些控制给闪光特技加一些杂色模板。

- Noise Pattern 选择杂色模板。点击右边的钮观看可用的模板清
单。

点击此处选择可用
的杂色模板
制作闪光特技
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- Amount 设置要加到特技上的噪声。值越高，噪声模板就越明显。

- Size 设置噪声模板里的失真部分的尺寸。将滑动指针向右拖增加
失真部分尺寸增加，反之则减少。

- Progression （X） 设置延水平方向的噪声模板的进程。

- Progression （Y） 设置延垂直方向的噪声模板的进程。

• Postprocessing 这些控制定义闪光颜色如何与源图像的颜色混合。
每种方式都要使用一种计算方法，同时用到闪光特技和源图像的像素
值。

- Mode 使用此控制选择需要的混合方式。点击右边的三角，扩展清
单。

• None 不混合，只显示闪光像素。

• Add 将源图像的像素值加到闪光像素值上。这会令特技更亮。

• Modulate 将闪光像素的值与源图像像素值相乘。这会令特技更
暗。

• Subtract 从闪光像素值里减去源图像像素值，创建一个新颜
色。

• Add Smooth 只在源图像低饱和度颜色像素上混合闪光像素值。
这会特技的效果更加精致。

• Add Signed 在源图像最亮的像素上加上闪光像素值。

• Blend 混合闪光像素值和源图像的 alpha 像素值。

• Blend Signed 混合闪光像素值和源图像最亮的像素值。

- Original Opacity 设置源图像的不透明度。

• Mask Settings 使用此控制选择一个遮蔽模板并调整透明度设置，
以定义图像上需要加闪光特技的部分。

- Enable Mask 选择此选项起用遮蔽。

- Mask Pattern 选择一个遮蔽模板。点击右边的钮观看遮蔽清单。

- Invert Mask 如果您想反转遮蔽区域的透明和不透明的部分，选
择此控制。

- Outside Transparency设置遮蔽外部区域的透明程度。

注：只有您使用自定义控制将遮蔽的尺寸缩小、移动或是旋转遮蔽，
遮蔽不覆盖整个屏幕时，才可使用 Outside Transparency。

- Shape Transparency Shape Transparency 选择遮蔽及周围区
域的透明度。默认设置为 （0），遮蔽为全不透明，周围区域为透

点击此处观
看遮蔽模板
，设置 Adobe Premiere Pro 实时特技
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明。将滑动指针向左拖增加遮蔽的透明度，令闪光特技明显程度下
降。将滑动指针向右拖减少遮蔽周围的透明度，令闪光特技更加明
显。

- Transform 使用此控制添加多种自定义设置，如位置、尺寸和旋
转。要了解更多信息，见 34 页 “自定义素材”。

• Crop 裁剪掉素材的边缘。要了解更多信息，见 37 页 “裁剪特技”。
制作闪光特技
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制作表面抛光特技
表面抛光特技可以为表面加上金属、砖块、木纹或是花岗岩的质感，带彩

色聚光灯效果。您还可以调节自定义控制，创建一个前后不同的旋转的板

块。

要设置 Matrox 表面抛光特技：

点击 Matrox Surface Finish旁的三角，扩展属性清单。

·Surface Control

- Apply to Opaque Areas Only 选择此选项在含 alpha 通道的素材的
不透明的部分加上表面材质。

注： 起用了这项功能后，您无法调节 Scale Z 的属性，因此您的素材

将是二维的素材。

- Surface Texture 可选择表面的材质。点击右边的钮，观看可用
的材质清单。

- Front Face Control

• Blending Factor 将板块的前表面与表面材质混和。值越高，

素材混合的程度越高。值为 0时只显示表面材质。

• Invert Video Orientation 选择此控制反转板块前表面的素

材。

• Crop 设置板块前表面的裁剪区域。要了解更多信息，见 37 页

“裁剪特技”。

- Back Face Control

• Blending Factor 将板块的后表面与表面材质混和。值越高，

素材混合的程度越高。值为 0时只显示表面材质。

• Invert Video Orientation 选择此控制反转板块后表面的素

材。

• Crop 设置板块后表面的裁剪区域。要了解更多信息，见 37 页

“裁剪特技”。
，设置 Adobe Premiere Pro 实时特技
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·Light Control

- Ambient Light Color 使用颜色选择器钮或是吸管，为整段素材

选择一个环境灯光颜色。

- Show Light Cursors 选择此选项，观看两个光源的参考点，以

帮助您设置灯光。设置完您的特技后，记得不选此选项。

- First Light 

• Enable 选择此控制启用第一个灯光。

• Color 使用颜色选择器钮或是吸管，选择第一个灯光的颜色。

• First Light Pattern 可以选择第一个灯光的模板。点击右边

的钮，观看可用的模板。

• Position X 设置第一个灯光在 X 轴的位置。

• Position Y 设置第一个灯光在 Y轴的位置。

• Position Z 设置第一个灯光的深度。

• Relative Position 选择此选项，设置第一个光源相对于素材

中心的位置。比如，如果您移动素材，第一个灯光也跟着移动。

默认设置是，第一个灯光与屏幕中心相对。

- Second Light 

• Enable 选择此控制启用第二个灯光。

• Color 使用颜色选择器钮或是吸管，选择第二个灯光的颜色。

• Second Light Pattern 可以选择第二个灯光的模板。点击右边

的钮，观看可用的模板。

• Position X 设置第二个灯光在 X 轴的位置。

• Position Y 设置第二个灯光在 Y轴的位置。

• Position Z 设置第二个灯光的深度。
制作表面抛光特技
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• Relative Position 选择此选项，设置第二个光源相对于素材

中心的位置。比如，如果您移动素材，第二个灯光也跟着移动。

默认设置是，第二个灯光与屏幕中心相对。

·Transform 可以修改多项阴影的自定义设置，比如修改尺寸、位置和

旋转素材以创建一个旋转的板块。

注：表面抛光特技的自定义属性里的 Scale Z属性定义板块的厚度。

要了解更多关于使用自定义属性的信息，见 34 页 “自定义素材”。

重要：如果您制作的是高清项目，在某些设置下，表面抛光特技有可

能需要生成。
，设置 Adobe Premiere Pro 实时特技
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制作跟踪遮片特技
Matrox 跟踪遮片特技可以使用一个遮片将一个素材叠加到另一个素材上
（也可以称为移动遮片）， 遮片决定两段素材的叠加方式。您可以使用以
下任意一种类型的素材作为遮片：

·一个灰度级视频或是图文视频。

·一个带 alpha 通道的图文素材或是图文序列。

·任何加了带 alpha 通道的特技的素材，如 Matrox 色度键特技或是 3D 
DVE。

在使用灰度级素材作为遮片时，遮片上黑色的部分创建前景素材透明的部
分，白色的部分挡住背景素材画面，灰色部分为前景素材半透明的部分。

要制作 Matrox 跟踪遮片特技：
1 将背景素材 （底下一层的画面）放在 Video 1 轨上。

2 将遮片素材直接放在背景素材上面的Video 2轨上，再加一个 Matrox 
Track Matte - Matte Identifier特技到这个素材上。这里面没有
任何设置，因为它只是用来标志这个素材是用于制作遮片特技的。

重要：在加了 Matrox Track Matte - Matte Identifier特技后，
再在此素材上加的特技都将被忽略。因此，如果您想在素材上加一个
特技，比如 Matrox 色度键或是使用 Matrox 3D DVE 或 Adobe Premiere 
Pro Motion 特技令遮片移动起来，您必须在加 Matrox Track Matte 
- Matte Identifier特技之前加这些特技。

3 将前景素材 （需要叠加到背景素材的素材）直接放到遮片上面的
Video 3 轨，再在此素材上加 Matrox Track Matte - Video 
Source特技。您的序列将与下图相似：

4 在 Effect Controls面板里，点击 Matrox Track Matte - Video 
Source旁边的三角扩展属性清单：

5 点击 Composite Type旁边的三角选择合成类型。

Matrox跟踪遮片特技 - Video 
Source 特技加在前景素材上

Matrox Track Matte - Matte 
Identifier特技加在遮片素材
上

点击选择合成类型
制作跟踪遮片特技
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您有以下选择：

- Alpha 使用遮片的 alpha 通道抠前景图像。这个选项只适用于含
alpha 通道的图文素材，或是已加了含 alpha 通道的特技的素材，
如 Matrox 色键特技。

- Luma 0-255 使用遮片里的全范围亮度电平抠前景图像。这个选项
只适用于遮片含超黑和超白亮度电平的情况。 

- Luma 16-235 使用遮片里的标准亮度电平范围抠前景图像。

6 要反转跟踪遮片特技的效果，选择 Reverse。键将反转，得到相反的
结果 （前景透明的部分变成不透明，不透明的部分变成透明）。
，设置 Adobe Premiere Pro 实时特技
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制作划像过渡特技
Matrox 划像过渡特技支持标准的叠化、SMPTE 划像和带柔边及彩色边框的
不规则划像。

要设置 Matrox 划像过渡特技： 

点击序列上的过渡特技图标，再点击 Effect Controls面板里的 Custom 
钮。出现 Customize Matrox Wipes对话框：

1 在 Wipe Pattern下，点击 Select Pattern钮并选择您的划像特技模
板。

2 如果您想给划像特技加一个边框，在 Border下选择 Enable。 

- Width 拖动滑动指针或是在文本框中输入一个百分数值调节边框
宽度。

- Color 点击此钮选择边框颜色。
制作划像过渡特技
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- Balance 可以选择在 A图像和 B图像的边框的突出程度。比如，
正值表示 B图像的边框更突出，负值表示 A图像的边框更突出。

- Reset 点击此钮恢复 Border的默认值。

3 使用 Softness下的为划像特技的边框加一个柔边。

- Nonlinear softness 此选项为默认选项。在使用某些划像特技
模板时，您有可能发现不选这个选项的效果更好。比如，非线性柔
度通常在创建 SMPTE 划像特技时效果较好，但在创建不规则划像
时，线性柔度效果较好。

- Amount 通过拖动滑动指针或是在文本框中输入一个百分数值调
节柔度值。值越高，边框的边缘越柔和。

- Reset 点击此钮随时可以恢复 Softness的默认值。

4 使用 Preview下的控制预览划像过渡特技：

- 拖动 Play钮旁边的滑动指针观看过渡特技。

- 点击 Play钮或是按空格键播放过渡特技。如果您想循环播放，按
Loop ，特技将循环播放，直到再按 Stop为止。

要了解更多关于设置过渡特技的信息，见您的 Adobe Premiere Pro 文件。
，设置 Adobe Premiere Pro 实时特技
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制作 Matrox 色度箝位特技
当您在素材的一部分加了需要进行色彩空间转换的特技时，您可以使用
Matrox 色度箝位特技确保素材的颜色一直保持一至。某些特技，如
Matrox 硬件加速特技和 Adobe Premiere Pro 自带特技都需要色彩空间转
换 （YUV 到 RGB），需要对素材的 RGB 值进行箝位处理，以转换成可接受
的 0-255 颜色分量。但这种箝位处理一般只用在非常明亮或是饱和度很高
的颜色上。

比如，如果您把一段包含很明亮或是很高饱和度颜色的素材分成两段，一
段加了 Matrox 3D DVE 特技，在监视器上看时，您有可能觉察到两段素材
之间的颜色有所有不同。您可以在没加特技的素材上加上色度箝位特技，
令素材前后色调保持一致。

选择速度控制方法
您可以选择最适合您的 Premiere Pro 项目的速度控制方式。默认设置是
Frame Blend，在视频场或帧之间插入，这个设置对于标准或是慢节奏的
视频比较合适。但如果您的项目包含较多快速变化的素材，不选此选项效
果会更好。

要改变 Timeline面板中的速度控制方法，右击素材，选择 Frame Blend 
以使用适用于标准或慢节奏的视频及摄像机的变速方式，对于快速节奏视
频，不选此项。

备注

·Frame Blend选项不支持超过 200% 的速度变化。

·如果您制作的是高清项目，不选 Frame Blend选项将需要生成。

关于 Adobe Premiere Pro 自带特技
在 Adobe Premiere Pro 中，Timeline面板上的每个素材都自动加一个特
技。选择序列上的素材后，它自带的特技出现在 Effect Controls窗口
中，所有自带特技都可以在 Effect Controls面板中调整。Adobe 
Premiere Pro 的自带特技包括 Motion 特技、透明度和音量特技。Matrox 
RT.X2 支持所有的 Premiere Pro 自带特技达到实时。
制作 Matrox 色度箝位特技
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Matrox RT.X2 实时规则
在 Adobe Premiere Pro 项目中，您可以使用多种 Matrox 基于 CPU 的特
技 （Flex CPU 特技）、硬件加速特技 （Flex GPU 特技）和 Adobe 
Premiere Pro 自带特技组合，所有特技都有透明度控制。

实时意味着素材无需生成而且可以实时播放，没有丢帧 （即，时间线上没
有红色条）。

Matrox 基于 CPU 的特技有划像特技、色彩校正特技、色键特技、亮度键特
技、移动和缩放特技、色度箝位特技和 Adobe Premiere Pro 的裁剪及变速
特技。Matrox 硬件加速特技为所有其它 Matrox 特技 （如卷页特技、3D 
DVE 特技、表面抛光特技、Premiere Pro 自带特技和淡入淡出等）。

注：硬件加速的特技只在使用支持 Adobe Premiere Pro 的 Matrox 硬件加
速特技的显卡时才可用。要了解更多信息，见 129 页 “在 Adobe 
Premiere Pro 里起用和禁用 Matrox 硬件加速特技”。

Matrox RT.X2 在您工作过程中不断分析序列，以识别需要生成的部分
（上面有一个红色条）。比如说，播放完序列后，序列上有丢帧的部分会
有一个红色条。即使您的系统在空闲的时候，Matrox RT.X2 也在分析决定
时间线上哪些部分需要生成。某些复杂特技或是特技组合在预览时有可能
造成丢帧。Matrox RT.X2 通过分析时间线，并系统地丢帧，令播放达到最
佳效果。 

如果您发现在输出到磁带时有丢帧，但丢帧的部分在时间线上并没有红色
条显示出来，您可以降低 Realtime Indicator Threshold。要了解更
多信息，见第 10 页 “定义常规设置”。

系统可以实时播放的最多的层数视系统的功能、项目的视频格式、素材的
压缩格式和使用的特技的复杂程度而定。
，设置 Adobe Premiere Pro 实时特技
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支持图文格式
Matrox RT.X2 支持 Adobe Premiere Pro 支持的所有全屏单帧图文素材达
到实时。包括 Premiere Pro 支持的所有字幕格式，如 Adobe Title 
Designer .prtl 文件。要了解所支持的格式的详情，见 Adobe Premiere 
Pro 文件。

注：不支持图文横飞、竖滚和动画达到实时。

限制
如果您有以下操作，您将需要生成：

·在素材里加了任何 Field Options， 比如 Always Deinterlace或
Flicker Removal。

·使用 Frame Hold命令给素材加了一个定格特技。
Matrox RT.X2 实时规则
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笔记
，设置 Adobe Premiere Pro 实时特技



Chapte r 4
使用 Matrox RT.X2 和 Video

for Windows 程序
本章介绍在 Matrox RT.X2 系统上如
何使用 Video for Windows 程序生
成素材。
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总介
在使用 Video for Windows 程序将素材生成为 .avi 文件时，比如完成的
视频作品或动画，可以使用 Matrox 编解码器创建 Matrox .avi 文件。比
如，您可能想将动画生成为 Matrox DV/DVCAM 格式，以录在 DV 磁带上。
还可使用 Video for Windows 程序将视频生成为 Matrox .avi 文件，这就
可以将这个文件作为实时素材输入到 Matrox RT.X2 的 Adobe Premiere 
Pro 项目中。 

以下章节介绍在 Matrox RT.X2 使用 Video for Windows 程序生成和采集素
材时所需的多种设置 .要了解如何将 Adobe Premiere Pro 视频输出为
Matrox .avi 文件，见 22 页 “Premiere Pro 输出到磁盘”。使用 Adobe 
Premiere Pro 输出 Matrox RT.X2 系统上的视频文件可突破 Video for 
Windows 程序的 2-GB .avi 文件限制。

注：虽然 Matrox 已测试过多种 Video for Windows 程序，在 Matrox 
RT.X2 上使用这些程序 （或未经测试的程序）时有可能有一些操作限制。

无需 RT.X2 硬件使用 VFW
如果您安装了 Matrox Video for Windows （VFW）软件编解码器 （见
《Matrox RT.X2 安装手册》“在无 RT.X2 硬件的系统上安装 Matrox VFW 软
件编解码器”），您可使用 Video for Windows 程序生成并播放 RT.X2 兼容
的 .avi 文件，无需安装 RT.X2 硬件。
, 使用 Matrox RT.X2 和 Video for Windows 程序
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生成之前
将素材生成为 Matrox .avi 文件之前，需要进行以下 Video for Windows 
程序设置：

• 按要生成的视频格式正确设置帧率。比如，如果您要生成 PAL 制式，就
将帧率设置为 25 fps。

• 将生成素材的帧尺寸设置为全屏：

- 720 ×480 如果使用 DV/DVCAM、DVCPRO 或 MPEG-2 I- 帧编解码器将素
材生成 NTSC 或 486p @ 23.98 fps 格式。

- 720×576 如果使用 DV/DVCAM、DVCPRO 或 MPEG-2 I- 帧编解码器将素
材生成 PAL 格式。

- 1440×1080 如果需要生成 MPEG-2 I- 帧 HD 格式。

• 要将视频生成与源素材一样压缩格式、帧尺寸和帧率，但画面质量
（数据率）、扫描方式 （隔行或逐行）不同，必须选择 Recompress 

Always 选项，这样视频将在输出时被重新压缩。

• 如果需要生成音频，将音频的取样率设置为 48 kHz 并将取样精度设置
为 16-bit （单声道或立体声）。

• 要达到最佳效果，请确保程序中生成素材的 Data rate limit 选项没
选。这一步确保 .avi 文件可以以选定质量生成。

• 如果使用 Adobe Premiere Pro，将 Fields 设置为生成 Lower Field 

First （NTSC），或 Upper Field First （PAL 和隔行扫描高清视频），
或是 No Fields (Progressive Scan) （逐行扫描视频）。

注：在生成大量素材前，请确认生成的动画和过渡特技，如划像和推移的
播放是否平滑。如果看上去跳跃，不稳定，请调整生成素材的场序。比
如，如果将场序设置为 Odd field 或 Field 1 时，过渡特技看上去跳跃，
试着将场序改成 Even field 或 Field 2。
生成之前
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第 4 章
选择色彩空间转换选项
当使用 Matrox VFW 编解码器将素材生成为 .avi 文件时，您可以决定在生
成过程中，亮度电平与色度信息在色彩空间转换中如何处理。

注：色彩空间转换默认设置已令大多数应用程序效果良好。我们建议只有
用于特殊目的时才改变这些设置。

要选择所需色彩空间转换选项：

1 右击 My Computer，选择 Manage，再双击 Device Manager。

2 在 Sound， video and game controllers 下，双击 Video Codecs。

3 点击 Properties，选择以下 Matrox VFW 编解码器：

注： 所有 Matrox VFW 编解码器都将被列出来。您可以选择 Matrox

VFW Software Codecs 来设置所有 Matrox DV、MPEG-2 I- 帧标清和 M-
JPEG、编解码器。

4 点击 Properties，选择 Settings。

5 在弹出的对话框中，在 Color Space Conversion 中选择所需选项。

注：如果您使用的编解码器不支持其中的一项选项，这项选项就会是
灰色的。但大部分选项对所有 Matrox VFW 编解码器来说都是通用的。
如果设置了一种编解码器的某个选项，也就同样设置了其它编解码器
此选项。 

- Standard 使用标准广播亮度电平生成视频。过黑和过白电平都被
箝位。

- DV-compliant 使用适用于 DV 素材的亮度电平生成视频，可保留视
频中的过白亮度电平。 

- Expanded 使用全范围亮度电平生成。保留过黑和过白亮度电平，
在需要进行亮度抠像时，您可能需要使用这个设置。

重要：当生成 RGB 图文时，选择 Expanded 或 DV-compliant，生成的图
像中都会出现过黑或过白部分。比如，如果选择 Expanded，所有 RGB
, 使用 Matrox RT.X2 和 Video for Windows 程序



117
图文中的黑色部分都变成过黑，白会变成过白。要用标准黑或白电平
生成 RGB 图文，将亮度范围设置为 Standard。

- Chroma filtering 和 Chroma interpolation 该选项调节 RGB 图文色
度带宽，改进图像颜色突变的部分，如黑或白背景上的蓝盒子。对
于大多数动画和合成作品 （计算机生成素材）应选择此项。对于大
多数视频编辑程序，最好动不要选此项。如果您觉得生成图像颜色
模糊，请去掉这些选项中的一项或两项。

- Chroma sampling for fast-motion video 该选项消除一些失真，如
快动作视频中出现锯齿边和不需要的线 （只适用于 PAL 制视频）。

重要：生成图文和字幕时，请确保没选 Chroma sampling for fast-

motion video，该选项会令生成的图像边缘出现锯齿边。

6 点击 OK 保存设置。选定亮度范围的任何设置改变（如从 Standard改为
Expanded）都将在下次启动 VFW 程序时生效。
生成之前
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第 4 章
将素材生成为 Matrox VFW .avi 文件
将素材生成为 .avi 文件时 （如生成完成的视频作品或是一个动画），必
须选择用来创建文件所需的压缩器 （编解码器）。压缩器决定生成视频的
质量。请参考应用程序资料，了解如何为 .avi 文件选择编解码器。

要创建一个 Matrox Video for Windows .avi 文件，从程序的可用编解码
器中选择需要的编解码器。

要创建 Matrox Video for Windows .avi 文件：

1 从程序的可用编解码器清单中选择一种编解码器：
- Matrox DV/DVCAM 将视频生成为 DV 或 DVCAM 格式。

- Matrox DVCPRO 将视频生成为 DVCPRO 格式。

- Matrox MPEG-2 I-frame 将视频以选定的数据率 （仅用于标准清晰
度）生成为使用 4:2:2 Profile @ Main Level 的 MPEG-2 I- 帧格
式。

- Matrox MPEG-2 I-frame HD 将视频以选定的数据率生成为使用
4:2:2 Profile @ High Level 的 MPEG-2 I- 帧格式。

注：还有其它 Matrox 编解码器可用，如 Matrox M-JPEG、DVCPRO HD
和无压缩高清编解码器。您可以使用这些编解码器创建用于其它
Matrox 系统，如 Matrox DigiSuite 或 Matrox Axio 上的素材。要了解
如何创建用于其它 Matrox 系统的 VFW 素材，见相应系统的相关文件。 

2 如果您选择了 Matrox MPEG-2 I-frame 或 Matrox MPEG-2 I-frame HD， 
点击 Configure 钮设置 MPEG-2 I- 帧设置。要了解更多信息，见 119 页
“设置 Matrox MPEG-2 I 帧编解码器”或 120 页“设置 Matrox MPEG-2 
I 帧高清编解码器”。
, 使用 Matrox RT.X2 和 Video for Windows 程序



119
设置 Matrox MPEG-2 I- 帧编解码器
当您点击程序的 Configure 钮设置 Matrox MPEG-2 I- 帧编解码器 （标准清
晰度）时，出现一个类似以下图的对话框：

1 拖动滑动指针，直到显示您需要的数据率 （视频质量）为止。数据率
越高，视频质量越好。但视您的系统功能不同，如果使用 Video for 
Windows 程序的视频质量设置过高，播放时有可能出现困难。 

2 点击 OK 存储您的设置。您以后每次使用这个程序生成素材时都会使用
这个设置，直到您再次修改它为止。
将素材生成为 Matrox VFW .avi 文件
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第 4 章
设置 Matrox MPEG-2 I- 帧高清编解码器
当您点击程序的 Configure 钮设置 Matrox MPEG-2 I- 帧高清编解码器时，
出现一个类似以下图的对话框：

1 拖动滑动指针，直到显示您需要的数据率 （视频质量）为止。数据率
越高，视频质量越好。但视您的系统功能不同，如果使用 Video for 
Windows 程序的视频质量设置过高，播放时有可能出现困难。 

2 在 Frame Rate 旁边，从清单中选择一个帧率。确保您选择的帧率符合
您要生成的高清格式。

3 点击 OK 存储设置。您以后每次使用这个程序生成素材时都会使用这个
设置，直到您再次修改它为止。
, 使用 Matrox RT.X2 和 Video for Windows 程序
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使用 Matrox 所见即所得插件

本章介绍如何使用 Matrox RT.X2 的
所见即所得插件在视频监示器上显
示项目内容。
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第 5 章
总介
Matrox 所见即所得插件配上 Matrox RT.X2 硬件，可以在视频监示器上显示
您正在制作的项目内容。您可以检查色温、字幕区域和隔行失真。支持以
下程序：

· Adobe After Effects （5.0 及更高版本）。

· Adobe Photoshop （7.0 及更高版本）。

· Autodesk 3ds Max （7.0 及更高版本）。

· Autodesk Combustion （4 及更高版本）。

· eyeon Fusion （4 及更高版本）。

· NewTek LightWave 3D （7.5 及更高版本）。

使用 Matrox 所见即所得控制面板
Matrox 所见即所得控制面板可以调整需要在视频监示器上显示的方法。要
使用 Matrox 所见即所得控制面板，右击 Windows 任务条上的  图标。
如果您见不到  图标 ,选择 Start > All Programs > Matrox Mx.tools > 

Matrox WYSIWYG Control Panel。

注：默认设置是起用 Matrox 所见即所得插件输出到视频监示器。要禁用
它，在控制面板里不选 Enable WYSIWYG Output 选项。

1 在 Project Format 菜单中，选择符合您正在制作的项目的格式，比如
NTSC 4:3。

2 在 Output Format 菜单中，选择您需要观看输出的格式。可用的输出格
式视您的项目格式而定。比如，如果您选择了 NTSC 项目格式，您就
只能选择 NTSC 输出格式。如果您选择了 HDV 1080i @ 29.97 fps 项目
格式，您可以选择 HDV 1080i @ 29.97 fps 输出格式，或者您可以选择
一个 NTSC 输出格式将高清视频下转换为 NTSC。 
注：如果 Adobe Premiere Pro 正在运行，Project Format 和 Output 
Format 将由 Premiere Pro 项目的视频输出设置决定。

3 从 Preview Type 菜单中，选择以下一种预览选项：

- Video 选择此项观看整个画面。

- Alpha Channel 选择此项只观看灰色级 alpha 键 （遮片）信息。
, 使用 Matrox 所见即所得插件
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使用所见即所得插件的步骤
以下内容介绍在使用每种程序时，如何使用 Matrox 所见即所得插件在视频
监示器上观看效果。

注：以下步骤适用于近期版本的程序，这些程序出现新版本时，以下步骤
有可能改变。

Adobe After Effects
1 打开 Adobe After Effects 并输入您需要观看的素材。

2 将素材从 Project 窗口拖动到 Composition 窗口。

Adobe Photoshop
1 打开 Adobe Photoshop 并输入您需要观看的素材。

2 选择 File > Export > Matrox WYSIWYG Preview。

Autodesk 3ds Max 
1 打开 Autodesk 3ds Max 并输入您需要观看的素材。

2 选择 Rendering > Render，打开 Render Scene 对话框。

3 在 Render Output 中，点击 Devices。

4 在 Select Image Output Device 对话框中，选择 Matrox WYSIWYG 

Preview， 再点击 OK。

5 点击 Render。

Autodesk Combustion
1 打开 Autodesk Combustion 并输入您需要观看的素材。

2 选择 File > Preferences > Framebuffer。

3 在 Framebuffer Type 旁边的菜单里，选择 Matrox WYSIWYG Preview£¨ 再
点击 OK。

eyeon Fusion
1 打开 eyeon Fusion 并输入您需要观看的素材。

2 右击文件，选择 View On > Matrox WYSIWYG Preview。
使用所见即所得插件的步骤
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第 5 章
NewTek LightWave 3D
1 打开NewTek LightWave 3D选择File > Load > Load Scene装载需要观看

的文件。

2 选择 Select Rendering > Render Options。
3 从 Render Display 菜单中，选择 Matrox WYSIWYG Preview。

4 选择 Rendering > Render Current Frame。
, 使用 Matrox 所见即所得插件



Chapte r 6
监控 Matrox RT.X2 系统
本章介绍如何使用 Matrox X.info 
程序显示 Matrox RT.X2 系统及所安
装的硬件的重要信息。
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第 6 章
使用 X.info显示 RT.X2 信息
Matrox X.info 程序可以显示 Matrox RT.X2 系统及所安装硬件的信息，并在
出现某些问题 (比如，当 RT.X2 板卡的温度超过了最高操作温度 )时报
警。如果您有一块支持 Matrox 硬件加速 (Flex GPU) 特技的显卡，您可以
使用 X.info 程序在 Adobe Premiere Pro 中起用和禁用这些 (见 129 页特技
“在 Adobe Premiere Pro 里起用和禁用 Matrox 硬件加速特技”) 硬件加速
特技。

您的计算机只要一开， Matrox X.info 就会启动。您可以双击 Windows 任
务条上的  图标，打开 Matrox X.info 以查看系统和硬件情况。

注：如果您没看到这个图标，右击任务条，选择 Properties （属性），再
不选 Hide inactive icons 选项，再点击 OK。

监控 Adobe Premiere Pro 内存用量
Adobe Premiere Pro 在运行时，您可以监控 Adobe Premiere Pro 的内存用量。
在 Matrox X.info( ) 图标上按住鼠标。会出现一个信息框，显示当前
Adobe Premiere Pro 内存用量。如果您的 Adobe Premiere Pro 内存用量很高，
X.info 将发出警告，提供更多信息。

显示系统信息
要显示 Matrox RT.X2 系统信息，从 Display Information About 清单中选择
System 。在这个页面中，您将会看到 Install Information，如安装路径和
Matrox Mx.tools 的版本。

您还可以创建一个系统信息的 HTML log 文件，这对排除故障很有用。要
创建这个 log 文件，使用 System Information Log 下的 Browse 钮选择 log
，监控 Matrox RT.X2 系统
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文件的路径和文件名，再点击 Create。如果选择了 Open file after 

scan， HTML 系统 log 文件将在被创建后自动打开。
使用 X.info 显示 RT.X2 信息
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第 6 章
显示硬件信息
要显示关于 Matrox RT.X2 硬件的信息，选择从 Display Information About 
中清单中选择 Hardware。 RT.X2 板卡和显卡都显示在上面的选项中。

点击板卡显示硬件信息 （比如，序列号和生产日期）。您还可以监控
RT.X2 板卡当前的和最高的操作温度。

重要：无论您是否打开了 Matrox X.info，只要 Matrox RT.X2 硬件的温度超
过了最高操作温度，您就将收到一个警告，并将指示如何处理，如 130 页
“故障提示”所示。
，监控 Matrox RT.X2 系统
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监控 RT.X2硬件操作温度
如 X.info Hardware 部分介绍，显示 Matrox RT.X2 硬件部件当前和最高操作
温度。要避免损坏 RT.X2 硬件和操作系统，请确保您的 RT.X2 硬件工作在
最高操作温度的时间不要过长。您应该尽量保证 RT.X2 硬件操作在低于最
高操作温度 10°C 的温度下。

您需要定期监控 RT.X2 硬件的操作温度，并采取措施降低室温或改进
RT.X2 系统的通风。要了解如何确保系统的正确通风，见 《Matrox RT.X2
安装手册》。

在 Adobe Premiere Pro 里起用和禁用 Matrox 硬件加速特技
在 X.info 程序有一个页面显示显卡的硬件信息。在这个页面里，您可以选
择在 Adobe Premiere Pro 中起用和禁用 Matrox 硬件加速特技。如果您的显
卡支持 Matrox 硬件加速特技，默认是选择 Enable Matrox hardware-

accelerated effects in Adobe Premiere Pro。如果您制作这些特技时系统
出现问题，您可能需要不选此选项，禁用这些特技。

要在 Adobe Premiere Pro 中使用 Matrox 硬件加速特技，您的 RT.X2 板卡必
须配置一块板上至少有 256 MB 内存而且支持 Microsoft DirectX 9 的显卡。 
如果 Matrox 测试了您的显卡并得出结论此显卡不支持这些特技，您就无
法使用 Matrox 硬件加速特技。您可以浏览我们的网站，了解更详细信息： 
www.matrox.com/video/cs/support。

如果您选择 Automatically check for Matrox-validated display card，每
次您打开系统， X.info 都将连接到 Matrox 视频网站上，以检测当前安装
的显卡是否支持 Matrox 硬件加速特技，并提示您是否可以起用这些特技。

注：如果您不想 X.info 自动检测您的系统是否有一个经 Matrox 认证的显
卡，您可以手动升级此程序，选择 Start > All Progams > Matrox 

Mx.tools > Check for Matrox-validated Display Card。您需要能够上网
才能完成这个升级。
使用 X.info 显示 RT.X2 信息

http://www.matrox.com/video/support
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第 6 章
故障提示
X.info 可提供温度报警和其它RT.X2硬件问题报警。一旦 X.info检测到一个
硬件故障，Matrox X.info Notification 对话框将会显示警告，并有进一
步的指示，介绍如何排除故障。如果故障不排除， 对话框将不会关闭。
，监控 Matrox RT.X2 系统
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标准和高级下拉

本附录介绍最常见的下拉方法，并
介绍 Matrox RT.X2 如何使用这些下
拉方法。
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附录 
总介
您在项目制作过程中有可能会用到下拉技术，将输入视频转换成您的项目
需要的格式。下拉还可以用于视频输出中，以满足某些要求。项目中需要
下拉时，Matrox RT.X2 要么执行标准的 2:3 下拉，或是高级 2:3:3:2 下
拉。

标准 2:3 下拉
标准 2:3 下拉经常被用于电视电影机，将 24 fps 的胶片转换为 29.97 fps 
隔行扫描视频。这种下拉方式还用于将任何 23.98 fps 逐行扫描视频转换
成 29.97 fps 隔行扫描视频，比如将 486p @ 23.98 fps 视频转换成 NTSC
制视频。 

要将 24 fps 胶片或是 23.98 逐行扫描视频转换成 29.97 fps 隔行扫描视
频，需要在视频序列中添加视频帧和场。比如，要将一个包含了 4 张胶片
的序列转换成逐行扫描的帧，需要 5帧视频，共是 10 场视频。因此需要
添加一帧视频或是 2 场视频。要做到这一点，4 张胶片的第一和第三张均
转换成两场视频，第二和第四张胶片分别转换成 3场视频，这种总共是 5
帧隔行扫描视频。

下图介绍转换过程： 

上面的图为胶片或是逐行扫描视频的帧，下面的图是对应的隔行扫描视频
场。标准 2:3 下拉是将胶片的第一张或是逐行扫描视频的第一帧 （A）转
换为两场视频 （a1 和 a2 场），第二帧 （B）转换为三场视频 （b1、b2 和
b3），第三帧 （C）再转换成两场视频 （c1 和 c2），第四帧 （D）再转换
成三场视频 （d1、d2 和 d3）。这个过程每秒重复 6次。

标准的反下拉与以上过程相反，将 29.97 fps 隔行视频转换成 23.98 fps
逐行视频。这个过程是去掉一个视频帧 （两场视频）。以上图中，典型的
反下拉会删除 b3 和 d1 场。这表示视频帧程序需要读 C和 D 帧，以去掉多

Film frames @ 24 fps or progressive frames @ 23.98 fps

A B C D

a1 a2 b1 b2 b3 c1 d2 d3c2 d1

Video frame A Video frame B Video frame C

Video fields @ 29.97 fps

Video frame D Video frame E
A， 标准和高级下拉
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余场。对于标准反下拉来说，处理的是压缩的视频，程序需要先解压缩
帧，以去掉多余的场，再重新压缩为原来的格式。

Matrox RT.X2 的标准反下拉
为了令 Matrox RT.X2 能够正确进行标准的反下拉，要从 29.97 fps 隔行扫
描转换成 23.98 fps 逐行扫描的素材必须开始就以 23.98 fps fps 采集。
当 Matrox RT.X2 进行标准反 2:3 下拉时，系统按帧的时间码是 0 还是 5
确定一个序列的 A帧。比如， 时间码为 00:00:20:20 或 00:00:20:25 的帧
将被定为 A 帧，将在下拉处理中被定为第一帧。

在批采集中，第一帧不一定是 A帧，RT.X2 会将下一个能作为 A帧的帧作
为 A帧 （如果需要的话）。为令 RT.X2 可以精确地进行反 2:3 下拉转换，
素材需要在时间码 0 或 5 处有一个 A帧。这个素材还必须使用连续不丢帧
的时间码录制。

高级 2:3:3:2 下拉
高级 2:3:3:2 下拉是作为另一种用于 DV 视频的帧率转换的标准下拉方法
开发的。它用于将 486p @ 23.98 fps 视频转换为 NTSC （486i @ 29.97 
fps）视频。当使用 DV 摄像机以 23.98 fps 采集并使用高级下拉录制到 DV
磁带时，需要使用这种高级下拉转换 （在某些设备上称为 24PA 或 24P 
Advanced 方式）。高级 2:3:3:2 下拉与标准 2:3 下拉的不同之处在于视频
序列的两个中间的帧每个都被转换成了三个视频场。
高级 2:3:3:2 下拉
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附录 
下图显示处理过程：

高级 2:3:3:2 下拉处理是这样 :第 1 帧逐行扫描视频 （A）转换为两场视
频 （a1 和 a2），第 2 帧 （B）转换为 3 场视频 （b1、b2 和 b3），第 3帧
（C）转换为 3 场视频 （ c1、c2 和 c3），第 4 帧 （D）转换为两场视频
（d1 和 d2）。

高级反下拉（2:3:3:2 ）转换将 29.97 fps 的隔行扫描视频转换为 23.98 
fps 逐行扫描视频。需要从视频序列里去掉一个视频帧 （两场视频）。从
上图中，典型的高级反下拉将去掉 b3 和 c1 两场视频。这表明系统可以从
序列中去掉 C 帧而无需读其它帧。

与标准反下拉相比，高级反下拉可以更好地保持转换后的视频质量，因为
从序列中去掉完整的一帧，其余的帧都可以完好地保留。

Matrox RT.X2 的高级反下拉
由于上图中多余的 C 帧在 23.98 fps 逐行扫描视频录制到磁带时已被打上
了标记，所以高级反下拉处理比标准反下拉处理要简单一些。这个信息已
包含在 DV 数据流里，Matrox RT.X2 进行高级反下拉时，它读到此信息，
找到多余的帧，就可以将它从视频序列里去掉。Matrox RT.X2 可以在一盘
录制了连续丢帧或不丢帧时间码的 DV 磁带上进行高级反下拉处理。

Progressive frames @ 23.98 fps 

A B C D

a1 a2 b1 b2 b3 c1 d1 d2c2 c3

Video frame A Video frame B Video frame C

Video fields @ 29.97 fps

Video frame D Video frame E
A， 标准和高级下拉
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Matrox RT.X2 工作流程

本附录提供在 RT.X2 系统上不同类
型的项目在 Adobe Premiere Pro 中
的工作流程。
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附录
总介
本附录介绍关于在 Adobe Premiere Pro 中处理不同类型的项目时使用的多
种 Matrox RT.X2 项目设置。我们使用工作流程图以更好地解释工作流程。

使用标准清晰度 “24P”素材
Matrox RT.X2 允许您选择一个 Premiere Pro 预设，以处理以 23.98 fps
或 24 fps 采集的标清素材。当您选择 Matrox 486p @ 23.98 fps 项目预设
时，只要素材是以 23.98 fps 或 24 fps 格式采集的，您就可以以 23.98 
fps 逐行扫描格式编辑标清素材。这包括由以 486p @ 23.98 fps 格式 DV
摄像机拍摄到 DV 磁带上的素材和以 24 fps 格式拍摄到胶片上并通过电视
电影机转录到磁带上的素材。您不可以使用 486p @ 23.98 fps 格式项目预
设采集或编辑以 NTSC 或 PAL 拍摄下来的视频。

无论原来是什么制式，以 23.98 fps （或以 24 fps 拍摄再转到 DV 磁带
上）格式采集的标清素材在录制到磁带上的时候都需要经过格式转换转成
NTSC （486i @ 29.97 fps）制式。这表明从您的源设备的输出和 Matrox 
RT.X2 的输入的格式总会是 NTSC。您的源设备在将素材录制到磁带上时加
一个下拉处理，将 23.98 fps 的素材转换为 NTSC 格式。以 23.98 fps 采集
的帧在录制到磁带时打上标记，然后 Matrox RT.X2 在采集时可以检测到
这些标记。

某些可以以 23.98 fps 逐行扫描格式拍摄的 DV 摄像机有添加标准或是高
级下拉的选项，以录制到磁带。我们建议您将摄像机设置为使用高级下拉
（某些摄像机叫做 24PA 或 24P Advanced 方式），以将素材转换为 29.97 
fps 隔行扫描视频，在 Matrox RT.X2 上编辑。Matrox RT.X2 在采集时就可
以加高级反下拉处理，将输入的视频转换为 486p @ 23.98 fps 以在 Adobe 
Premiere Pro 中编辑。

从 Matrox RT.X2 输出的 486p @ 23.98 fps 项目均为 NTSC 制。RT.X2 提供
选择高级下拉还是标准下拉的选项。在大多数情况下，您只在视频需要进
一步处理或是需要存档的情况下才选择高级 2:3:3:2 下拉。否则，系统在
将 486p @ 23.98 fps 项目输出到磁带上时将使用标准 2:3 下拉。要了解
更多关于标准 2:3 下拉和高级 2:3:3:2 下拉的信息，见附录 A “标准和高
级下拉”。
B， Matrox RT.X2 工作流程
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486p @ 23.98 fps 工作流程举例
以下工作流程图显示在 Matrox RT.X2 上的典型 486p @ 23.98 fps 工作流
程：

注：所有 Matrox RT.X2 项目，您都可以选择输出为 MPEG-2 文件用于 DVD
刻录或是按 26 页 “使用 Matrox Media Encoder 输出素材”所述使用
Matrox Media Encoder 输出为网络格式。
使用标准清晰度“24P”素材
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附录
使用高清晰度素材
Matrox RT.X2 可以通过 1394 接口采集原始 HDV 素材和将高清模拟分量输
入采集为 MPEG-2 I- 帧高清格式。原始 HDV 和 MPEG-2 I- 帧高清素材可以
在同一个高清项目上实时混编。您还可以输入标清素材到高清项目上，
Matrox RT.X2 可以如第 9页 “在同一项目上混编标清和高清素材”所述
实时上转换素材用于编辑。

Matrox HDV 1080i @ 29.97 fps 和 HDV 1080i @ 25 fps 项目预设是用于
采集为原始 HDV 或 MPEG-2 I- 帧高清格式的，但无论您选择哪个预设来创
建您的项目，您都可以随时改变采集设置，在使用 DV-1394 输入采集原始
HDV 和将高清模拟分量视频采集为 MPEG-2 I- 帧高清格式之间切换。要了
解更多关于采集 MPEG-2 I- 帧高清格式的信息，见 141 页 “使用 Matrox 

MPEG-2 I- 帧高清编解码器”。

完成编辑后，您可以将项目通过 1394 接口输出到 HDV 设备，或是使用
Matrox RT.X2 的高清模拟分量输出接口输出到磁带。您还可以选择将视频
下转换为 NTSC 或 PAL （视您的项目的帧率而定），以录制到标清磁带上。
B， Matrox RT.X2 工作流程
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HDV 工作流程举例
以下工作流程图显示在 Matrox RT.X2 上的典型 HDV 1080i @ 29.97 fps 
或 25 fps 工作流程：

注：您还可以选择以高清或标清格式输出到磁盘。比如，您可以将一个
HDV 1080i @ 29.97 fps 项目输出为与项目格式相同的 .avi 文件或是
NTSC 视频。要了解更多信息，见 22 页 “Premiere Pro 输出到磁盘”。
使用高清晰度素材
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附录
采集 HDV 和标清素材，使用标清格式编辑
如果您想保留 HDV 摄像机的高质量画面的同时，又以标清格式输出项目，
您可以通过 1394 接口采集 HDV 素材，在 Matrox RT.X2 上以 NTSC 或 PAL
格式编辑。方法如下：您先创建一个 HDV 1080i @ 29.97 fps 或 25 fps 项
目，并通过 1394 接口采集原始 HDV 素材，再创建一个 NTSC 或 PAL 项目，
并输入 HDV 素材。

在编辑标清项目时，您可以通过 1394 接口采集原始 DV 素材，再使用
Matrox RT.X2 的模拟分量、S-Video、或复合输入采集标清素材。标清和
HDV 素材可以在同一项目上实时混编。在将素材转换为项目的帧尺寸时，
HDV 素材将如第 9 页 “在同一项目里混编高清和标清素材”所述，被下转
换为 NTSC 或 PAL 格式，以实时播放。

编辑完成后，您可以将项目以 NTSC 或 PAL 视频格式输出，用于播出。如
果您想输出高清格式，您可以在 HDV 1080i @ 29.97 fps 或 25 fps 项目中
输入标清项目。之后您可以无需重新采集素材就输出高清格式 （标清素材
可以上转换为 HDV 1080i 用于实时播放）。

工作流程如下图所示：

Matrox project using
an HDV 1080i @

29.97 fps or 25 fps
project preset

Matrox project using
an NTSC or PAL

project preset (HDV
clips are downscaled)

Exported to tape as
NTSC or PAL video

for broadcast

Project imported to an
HDV 1080i project for

delivery in HD
(SD clips are upscaled)

HDV clips captured
natively over the
1394 interface

DV clips captured
natively over the

1394 interface, and
SD clips captured

using analog inputs

HDV clips
imported to SD

project
B， Matrox RT.X2 工作流程
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使用 Matrox MPEG-2 I 帧高清编解码器
Matrox MPEG-2 I- 帧高清编解码器令您可以控制采集或输出的视频的数据
率。低数据率 （约 50 Mb/sec）时，编解码器可用于采集和输出视频，用
于脱机编辑的项目。高数据率时 （90 Mb/sec），编解码器可用于采集和
输出高质量视频，用于联机编辑项目。VFW MPEG-2 I- 帧高清编解码器可
在 VFW 程序 （如 Adobe After Effects）中生成并播放 MPEG-2 I- 帧高清
素材。

MPEG-2 I- 帧高清编解码器脱机编辑工作流程举例
在以下的工作流程例子中，Matrox MPEG-2 I- 帧高清编解码器用于采集视
频素材，用于脱机编辑项目。素材通过 Matrox RT.X2 以 50 Mb/sec 数据率
采集，再用于完成脱机编辑项目。当脱机编辑完成时，项目精确调节完
毕，脱机素材的链接断开，再使用数据率为 90 Mb/sec 及以上的 Matrox 
MPEG-2 I- 帧高清编解码器重新采集。联机编辑项目完成后，再输出用于
播出。
使用 Matrox MPEG-2 I 帧高清编解码器



142

附录
工作流程如下图所示： 

Analog component video
footage shot as 1080i @ 29.97

fps or 25 fps

Matrox MPEG-2 I-frame HD
codec set at 50 Mb/sec used

to capture clips

Matrox offline editing project
using an HDV 1080i MPEG-2

I-frame project preset

Offline project is trimmed,
offline clips are unlinked and
recaptured using the Matrox

MPEG-2 I-frame HD codec at
90 Mb/sec or higher

Exported to tape as finishing-
quality HD video for broadcast
B， Matrox RT.X2 工作流程
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MPEG-2 I- 帧高清编解码器联机编辑工作流程举例
在以下的工作流程例子中，Matrox MPEG-2 I- 帧高清编解码器用于采集视
频素材，用于联机编辑项目。素材通过 Matrox RT.X2 以 90 Mb/sec 及以上
数据率采集，再用于完成联机编辑项目。 使用一个 VFW 程序 （如 Adobe 
After Effects）制作，再用 VFW MPEG-2 I- 帧高清编解码器生成并输入到
联机编辑项目中。联机编辑项目完成后，再输出用于播出。 

工作流程如下图所示：

Exported to tape as finishing-quality
HD video for broadcast

Matrox MPEG-2 I-frame HD codec
set at 90 Mb/sec or higher used to

capture clips

Matrox online editing project using
an HDV 1080i MPEG-2 I-frame

project preset

VFW application, such as
Adobe After Effects, uses
the MPEG-2 I-frame HD
clips. The compositing

project is rendered using
the Matrox VFW MPEG-2

I-frame HD codec.

Clips rendered using
the Matrox VFW
MPEG-2 I-frame HD
codec are imported into
the online editing
project.

MPEG-2 I-frame HD clips used
in a VFW application on the
RT.X2 system or an offline
editing station.

Analog component video
footage shot as 1080i @ 29.97

fps or 25 fps
使用 Matrox MPEG-2 I 帧高清编解码器
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附录
使用 Matrox RT.X2 编辑 Axio 脱机高清项目
Matrox RT.X2 支持实时播放 Matrox Axio 脱机高清素材，您可以使用
Matrox RT.X2 系统作为 Matrox Axio 脱机高清项目的脱机编辑工作站。
Matrox Axio HDV 1080i （1440×1080） @ 29.97 fps 或 25 fps 项目可
以直接在 Matrox RT.X2 上打开，脱机高清素材可以达到实时。

Matrox RT.X2 不支持 Matrox Axio 全尺寸 1080i （1920×1080） @ 29.97 
fps 或 25 fps 项目，因此，要编辑这个脱机项目，您需要按以下步骤在
Matrox RT.X2 上将此项目输出到一个 HDV 1080i 项目中：

1 选择 File > New > Project，在 Matrox RT.X2 上创建一个新的 Adobe 
Premiere Pro 项目，从 Available Presets 清单中，选择相应的 Matrox 
HDV 预设。比如，如果您想输入 Axio 1080i @ 29.97 fps 项目，选择
Matrox HDV 1080i 29.97 fps 预设。

2 选择 File > Import，找到您的脱机 Premiere Pro 项目（.prproj）文件，
输入 Axio 1080i 项目。

提示 ： 要在 Import 对话框中看到 .prproj 文件的清单，您需要从
Files of type 清单中选择 Adobe Premiere Pro Projects (.prproj) 。

3 现在您可以在 Matrox RT.X2 系统上编辑脱机文件了。编辑完成后，您
可以 直接在 Matrox Axio 上打开此项目，或是输入到一个新的 Matrox 
Axio 1080i 项目中。
B， Matrox RT.X2 工作流程
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支持的视频压缩格式
下表显示在各种项目格式下 Matrox RT.X2 支持的视频压缩格式。

1 如第 9 页“在同一项目上混编标清和高清素材”所述在同一项目里混编标清和高清

素材时，也支持实时播放。

2 在将一个高清项目输出为 Matrox .avi 文件时，您可以选择将高清视频下转换为

任何支持的标清视频格式。要了解详情，见 22 页 “Premiere Pro 输出到磁

盘”。

SD 项目 HD 项目

采集
DV/DVCAM
DVCPRO
MPEG-2 I- 帧

只有 DV-1394 输入：
HDV
只有模拟分量输入：
MPEG-2 I- 帧 HD

播放 1
DV/DVCAM
DVCPRO
MPEG-2 I- 帧

HDV
MPEG-2 I- 帧 HD
脱机高清格式
（可以播放 Matrox Axio 脱
机高清项目）

输出到磁盘
DV/DVCAM
DVCPRO
MPEG-2 I- 帧

MPEG-2 I- 帧 HD
（可下转换为任何支持的标
清格式）2

生成预览
DV/DVCAM
DVCPRO
MPEG-2 I- 帧

MPEG-2 I- 帧 HD

DV-1394 输
出到磁带

DV/DVCAM
DVCPRO

HDV
支持的视频压缩格式
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附录
支持的主输出格式
下表显示在不同项目视频格式下支持的主输出格式。

注：用于 HDV 1080i (1440×1080) 项目的 HDV 模拟分量输出总是全尺寸
1080i (1920×1080) 的。

项目视频格式
Matrox RT.X2 支持的主输出格
式

NTSC NTSC

PAL PAL

486p @ 23.98 fps NTSC

HDV 1080i @ 25 fps 1080i @ 25 fps 或 PAL

HDV 1080i @ 29.97 fps 1080i @ 29.97 fps 或 NTSC
B， Matrox RT.X2 工作流程
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Matrox RT.X2 客户支持

本附录介绍如何注册 Matrox RT.X2
并获得客户支持。
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附录 C，Matrox RT.X2 客户支持

大部分客户支持来源
如果您在使用 Matrox RT.X2 过程中出现问题，查询使用手册也无法解

决，请与您地区附近的 Matrox RT.X2 代理商或 Matrox 公司联系。

注册
您可以在 Matrox 网站的 RT.X2 技术支持部分 (http://www.matrox.com/
video/cs/support) 注册产品，以获得技术支持。要直接进入此网页，点
击Start > All Programs > Matrox Mx.tools > Register Your Matrox RT.X 

System。

重要：只有注册用户才会获得客户支持、软件升级、进入用户论坛并获得
促销优惠。

从网站上了解最新消息
除了注册 Matrox RT.X2 外，我们网站会为您提供最新 Matrox 产品信息和
免费软件升级。请将我们的网址 www.matrox.com/video/cs/support 放在
您的收藏夹中。

与我们联系
Matrox 提供覆盖全球的优质客户支持，请按我们网站上提供的信息与您地
区的客户支持部门联系 www.matrox.com/video/cs/support。

www.matrox.com/video/support
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